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Instruction Sheet Learning Guide #13 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Basic computer skill 

 Introduction to drawing software and drawing principle  

 instructing and operating procedures for the CAD software 

 booting the CAD software  

 Screen display areas and basic parameters 

 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to: 

 instruct and operate All relevant manuals, 

procedures for the CAD software are obtained in accordance with workplace 

procedures. 

 bootThe CAD package in accordance with 

workplace procedures. 

 set Screen display areas and basic parameters 

are in accordance with instructions  

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 2 

3. Read the information written in the information “Sheet 1, Sheet 2, Sheet 3 , and Sheet 4 ,  

4. Accomplish the “Self-check 1,Self-check t 2, Self-check 3, Self-check4 , Self-check 5, 

Self-check 6   and Self-check 7” in page -17, 27, 31,and50respectively.  
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1.1Basic computer skills" 

is a term that is used to identify the essential skills needed in order to make use of a 

computer. The scope of skills that are considered basic will vary from one situation to 

another. For example, one employer may consider the ability to make use of a specific type 

of word processing software to be among the basic skills required, while a different 

employer will place more emphasis on the ability to work with electronic spreadsheets. 

Trade schools and some colleges offer courses that introduce students to basic computer 

skills most commonly required by employers, making it easy to secure the knowledge 

needed to identify and hone these skills. 

As a basis for making use of a computer, basic computer skills will often start with 

understanding how a particular operating system functions in terms of the creation and 

placement of taskbars on the computer desktop, how to make use of a computer mouse to 

utilize the programs housed on the hard drive, and even how to go about using an email 

program to create, send, and receive emails. Tasks such as searching for files on a hard 

drive are often also considered basic skills that any user should know and be able to 

perform with relative ease. In some cases, training in how to conduct searches using an 

Internet browser will also come under the heading of basic operational skills, especially if 

the job position requires frequent research. 

 

OPERATINGSYSTEMS 

The Operating System(OS) 

 
Computers without operating systems are exactly like televisions without a  
signal: Theywill turn on, but you will be looking at a blank screen 
with no hope of interacting with it (thelights are on, but nobody’s  
home)! The most popular operating system is “Microsoft  
Windows,” andit is utilized by most personal computer (PC) 

Information Sheet-1 Basic computer skill 
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users.It is what you are using today in class.If you thinkof the 
CPU as the “brains” of the computer, theoperating system acts 
as the nervous system of the computer, connecting the CPU           Fig. 1.1 
to all the computer programs.The operating system allows you to run other  
programs, work on projects, and do basically everything else that computers are 
capableof.There are many differentversions of Microsoft Windows, and a new 
version is released every couple of years (just like car models).  

 
There are other operating systems as well.Apple manufactures a 
computercalled a Macintosh, or Mac.Macsuse an operating 
system called “Mac OS X” which, while it looks very different from  
Microsoft Windows, runs using the same basic principles. While  
fewer people use Macs than PCs, schools often use Macs, as well 
as people who work with graphic design and video and image  
editing.As a general rule, Macs tend to be more expensive than PCs.Fig. 1.2 

 
You shouldn’t ever need to messwith the operating system.Itshouldrun 
correctly and without error for as long as you have your computer.In fact, if you  
ever take your computer in for a repair, the technician will be looking primarily at  
your operating system (not your programs), in the same way that a mechanic will 
look at your car’s engine.  

 
The operating system of your computer is so important, that any computer you  
buywill be sold with one already installed and ready to go (so outside of  
choosing between a PC and a Mac, you don’t really need to worry about the  
operating system except to make sure you get the newest or most appropriate  
version).In addition, popular software programs are also oftenalreadyinstalled 
on computers, so all you have to do is plug your computer in and go!  

 
Computer Manufacturer (e.g.Apple 
Lenovo)Computer is called a Macintosh 
Computer is called aPC(Mac) 
Operating System isWindowsOperating System isOSX 
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Fig. 1.3 Computer Manufacturer (e.g. Apple  
Lenovo) 
Turning On the Computer and Logging On: 

 
Turning the Computer On 

 
Let's get started! As you sit down at your desk, you can assume that your 
computer system is one of three states:  

 
•OFF: This is exactly what it sounds like: The computer is off, and no parts  

are running or working.The monitor is black (no images), there is no 
“whirring” sound from the CPU, and the computer is unresponsive to 
mouse movements or pressing keys on the keyboard.The power button (if 
it lights up) should not belitup. 

 
•ON: When a computer is on, you should see images on the monitor,  

possibly heara“whirring”noisecoming from the CPU (hopefully not too 
loud!), and the pointer on the screen (the small white arrow) should  
respond when you move the mouse.  

 
•SLEEPMODE:Most computers have a mode called “Sleep,” inwhich the  

computer is on, but has assumed an energy-efficient, minimal power  
mode.To “wake”thecomputer, simply move the mouse around or press  
the space bar onthe keyboard,and it will “wake up” and return to the  
exact same place that itwas when itwentto sleep.In other words, if you  
were using a word processing program and the computer went to sleep, it 
would return to exactly what you wereworking on when it wakes up. 

 
To turn a computer on, simply press the power button once (no need to hold the  
button—just press and release).We will go over how to turnoffa computerlater 
in this handout. 
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8 

 
Logging On 

 
Once you turn the computer on, the computerwill go through a series of  
automated tasks before it is ready for you to interact with it; this process is called 
“startup.” This process will last between one and two minutes. If the computer is  
notworking correctly, you may see an error message during startup.If the  
computer is performing as it should, however, you will probably see one of the  
following screens:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 1.4 Logging On 
This is called a“LogOn” window, and it means that the computer is password 
protected.If you do not see this window upon starting the computer, you can  
assume that your computer is NOT password-protected and may be used by 
anyone.To log on, you simply enter your user name and password.If you are 
using a public library computer, this could be your library card number.
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The Desktop 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 1.5 The Desktop 
After you log on, the computer will display what is known as your desktop within 
a few seconds to a few minutes (if your computer is newer, this will probably go  
faster).Here you will see a digital representation of something similar to a real- 
life office space, complete with a workspace, files and file folders, and even a  
recycling bin!  

 
One of the neatest features about Microsoft Windows is that your desktop may 
not look anything like the one above! While this may sound confusing, it means  
thatyou are able to personalize, alter, and change almost everything aboutyour  
desktop environment.If you do not like the color blue as your background, where 
the icons are, or even what language it is in, you can change it! Here are some  
examples:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 Fig. 1.6The Desktop 
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THEKEYBOARDANDMOUSE 

Keyboard Commands 

 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 1.7Keyboard Commands 
 
In order to use your computer effectively, you must interact with it using both the 
mouse and the keyboard.The above image of a keyboard may closely resemble 
(if it is not identical to) the keyboard in front of you; learning the function of just a  
few keys will help you to interact better with your computer and individual  
programs.The following is a list of commonly used keys that have special  
functions (keep in mind that key functions can change dependingon which  
programyouareusing): 

 
1.Backspace: This key deletes letters backward ().  
2.Delete: This key deletes letters forward ().  
3.Shift: This key, when pressed WITH another key, will perform a  

secondary function.  
4.Spacebar: This key enters a space between words or letters.  
5.Tab: This keywill indent what you type, or move the text to the right. 

The default indent distance is usually ½ inch. 
6.Caps Lock: Pressing this keywill make every letter you type  

capitalized.  
7.Control (Ctrl): This key, when pressed WITH another key, performs a 

shortcut. 
8.Enter: This key either gives you a new line, or executes a command 

(pressed in a word processing program, it begins a new line). 
9.Number Keypad: These are exactly the same as the numbers at the  

top of the keyboard; some people find them easier to use inthis position. 
10.Arrow Keys: Like the mouse, these keys are used to navigate through a  
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document or page. 11 
 
The Mouse 

 
While the keyboard is primarily used to insert/input and manipulate text and  
numbers on a computer, the mouse is used mostly for navigating aroundthe 
screen.Mice come in a variety of shapes and sizes.Some ofthe strangest- 
looking mice often look thatway because they are designed to be more  
ergonomic than traditional mice.  

 
 
 
 
 
There are traditional mice…unusually shaped mice… 

 
 
 
 
 
 
 
 
 
 
 
 
stylish mice…complicated mice… 
 
 
 
 
 
 
 
 
 
 
 

and real mice!Fig. 1.7The Mouse 

 

 
The type of mouse that you choose to use is totally based on your preference—If 
you want a fancy mouse, that’s fine; if you prefer a simple mouse, that’sOK too. 
Each mouse, however differentit may be, has similar functions.As you can see  
onthe “traditional” model above, a traditional mouse has two buttons with a  
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wheel betweenthem (gray) that spins, called a “scroll wheel.” Both buttons can  
perform separate functions, and are referred to by which side of the mouse they 
are located on.12 
 
 
Pressing the LEFT mouse button is called“left-clicking,” while pressing the 
RIGHT mouse button iscalled“right-clicking.” 

 
Left-clicking is used far more often than right clicking.For now,know thatleft- 
clicking is used to select or click on something, while right-clicking presents  
additional menu options. 

 
Practice 

 
Keyboarding Practice! http://www.sense-lang.org/typing/tutor/keyboarding.php 

 
Left-Clicking, Double-ClickingandRight-Clicking 

 
One of the most difficult things to learn when first beginning to use a computer, is  
how to use the mouse.It takes coordination, precision, and patience.Fortunately, 
the moreyou practice, the easier it will become!  

 
The mouse symbol, or pointer, that appears on the computer screen will change 
its look and function depending on what it is near or hovering over.  

 
Your mouse pointer will most often look like an arrow 

When your mouse pointer is over an internet link, it will look like apointing 
hand 

When your mouse pointer is over a place where you can type, it will look like 
an I-beam  

 
When your computer is busy or ‘working,’ your mouse pointer may look 

like an hourglass or a spinning circle. 

 
There are actually many different pointers (though these are the most common), 
and theywill change automatically depending on what task you are trying to  
perform. 

 
The buttons on the mouse may also have different functions, depending on  
which program you are using.If you are working in Microsoft Word, for example, 
the mouse will offer options related to Microsoft Word.Conversely, if you are  
working in Microsoft Excel, the mouse will offer options related to Microsoft  
Excel, and so on.  

 
For now, remember these rules: 
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1.The LEFT mouse buttonSELECTSitems. 

2.The RIGHT mouse buttonGIVES YOU MOREFig. 1.7 The Mouse 
OPTIONS.13 

 
3.Double-Clicking the LEFT mouse button EXECUTES options (for  

example, you can open a program by double-clicking an icon on the 
desktop). 

4.Double-Clicking the RIGHT mousebuttondoes not do anything. 

 
Practice Exercise 

 
Mousing Around! http://www.pbclibrary.org/mousing/intro.htm 

 
This exercise will let you practice a variety of the skills you’ll need to use your 
mouse effectively.Try this practice site from any computer connected to the  
Internet 

 

NAVIGATINGTHECOMPUTERANDSOFTWARE 

The Start Menu 

 
The Start Menu is a good place to, well, start! The Start button (which opens  
the menu) is located in the lower left corner of your screen.LEFT-CLICKonceon 
the Start Button to open the menu.  

 
This is the Start Menu as it appears in Windows 
7.  

 
Notice the options that are available in this  
menu.Popularprograms, like the calculator  
and paint applications are on the left, while  
folders, the Control Panel, and help features are 
on the right.  

 
Also note the“Shut Down”button at the bottom  
of the menu.This button is veryimportant.It will  
allow you to log off or shut down the computer.  
Logging off a computer islikelockinga car—the 
computerisina 
stationary mode and  

Fig. 1.8Start Menu 
you can’t do anythingfrom the outside.Clicking Shut  
Down is like turning off the engine. WhenyouclickShut 
Down, the computer has an opportunity to properly 
“shut down” before the poweris turned off.  
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We will cover how to log off and turn the computer off in 
more depth later in this handout. 

Fig. 1.8 Start Menu 
By LEFT-CLICKING once on “All Programs,”another 
menu will appear.This is a list ofall the programs that 
 
you have installed on your computer. 

 
Nearly everything that you can do with your computer can be found in the Start 
menu.This includes finding help, using programs, getting on the Internet, e- 
mailing, playinggames, customizingyour desktop, and more!  

 
You should feel free to experiment with the Start Menu.Go ahead and left-click 
on something!  

 
Microsoft Windows has undergone many changes over the past few decades. 
New versions of the operating system are released every couple of years.Itis  
currently being released in a version called “Microsoft Windows 8.” Past versions 
include: “Windows 95,” Windows 98,” “Windows ME,” “Windows XP,” “Windows  
Vista,” and “Windows 7.” Many people continue to use Windows Vistaand 
Windows 7, even though newer versions have been released.It is important to  
know that there are different versions of Windows, because different features  
(such as the Start Menu discussed above) may look different in different  
versions. 

 
Managing “Windows” 

 
Microsoft Windows is called  
“Windows” for a reason.Programs 
appear on your screen as “Windows” 
(rectangular shapes) andare laid 3- 
dimensionally on top of one another  
(see image at right), just like on a  
real desktop.The desktop is your  
work surface, and all of your open  
windows appear on top of it. 
 Fig. 1.9 “Windows” 
If you can see a window,that means the program is openand running.Itis 
possible to make the window bigger, smaller, or close it using the buttons in the 
top right corner of any window.
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Minimize:Maximize:Close:Left-Restore 
Left-clickthisLeft-click thisclick thisDown:Left- 
button tobutton to makebutton to closeclickthis  
shrink thethewindow asthe window.buttonto make 
window downlarge as it canThe programthe window 
to a smallbe—it shouldwill close andsmaller without 
button thatwilltake up yourstop running.minimizing it.  
appear in theentire screen.Makesureyou 
task bar (seesave your work 
below).first!  

 
 
 
 
 Fig. 1.10“Windows” 
Microsoft Windows is capable of running more than one program at once.In 
other words, you can write a letter in Microsoft Word, whilesurfing the Internet  
whileusing Microsoft Excel whilechecking your e-mail and so on! This is called  
“multi-tasking” and is a feature of all computers.However, with all of these things 
going on at once, how do you keep track of them all? TheTaskbar,which is the  
bar that spans across the bottom of your screen next to the Start Menu, is  
designed to help you keep track of all of your programs.It looks like this:  

 
 
 Fig. 1.11 
In the illustration above, there are several programs running.Each program that  
is open is represented by a “button” on the Taskbar.Touse one of the programs 
thatis“open,” simply left-click on it once to bring it up to the top of the screen.  
The taskbar is modeled after what might happen in real life: You are reading the  
newspaper, and you put it down to pick up your favorite book.You didn’t throw it  
out or destroy it, you simplyset itaside.Thisway, you can pick up right where  
you left off once you are done reading your book.The taskbar works the same  
way, but with software programs, not books. 

 
Buying a Computer 

 
When considering the merits of a computer, it’s important to consider the 
followingquestions:  

 
•How fast can the computer perform tasks?  

•How much information (or data) can it store?  

•How many programs (i.e.software) can it run simultaneously? 
 
Buying a computer is a big decision, and can be quite expensive.It is a good 
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idea to do some research before buying a computer to find out whatwould work 
best for your needs, what computers have performed well for others, andwhat 16 
 
models are within your price range.Asking for help finding this information at the 
reference desk of your local library is a good place to start.In addition, here are 
somewebsites you might want to check out:  

 
•http://www.consumerreports.org/(under electronics, select “Computers”) 

•http://www.ehow.com/how_3038_buy-computer.html 

•http://www.pcworld.com/article/125649/how_to_buy_a_desktop_pc.html 

•Personal computer companies: 

•http://www.dell.com/ 

•http://www.lenovo.com/ 

•http://www.hp.com/ 

 
Other Programs and Software 

 
Although there may be lots of software pre-installed on your computer when you  
buy it, there are many more programs available for you to download or buy, from 
educational games for children to photo editing software to professional  
programming software.If you are interested in a particular type of software,here 
are some suggested Web sites to check out:  

 

•http://www.pcmag.com/ 

•http://www.compusa.com/ 

•http://www.amazon.com/ 

•http://www.microsoft.com/ 

Keep in mind that software is often designed foreither aPCora Mac, so make  
sure whatever program or game you purchase is compatible with your particular 
computer.If software is compatible with both types of computers, it will often  
have a symbol like this:  

 
 

Mac 

 
 

PC 
 
 
Fig. 1.12 
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7 

 

SHUTTINGDOWNTHECOMPUTER 

Logging Off vs.Shutting Down 

 
To log off or shut down the computer, click the Start button: 

 
 
 
 
 
 
 
 
 
Fig. 1.13Logging Off vs. Shutting Down 
Logging off your computer and shutting down your computer are two 
different  
things.Remember the analogy of the car:Logging off a computer is 
likelocking 
the car (the computer ispassword-protected and you can’t do 
anything).When 
you first log in to a computer, it’s like using a key (password) to get in, 
and when  
you are done using the computer, you need to log off (the computer will 
remain  
on) to make sure no one can make changes while you are away. 

 
By contrast, when you click Shut Down, it is like turning a car’s ignition 
off.You  
need to make sure that processes and programs are properly ended 
and shut  
down before pushing the shutdown button, just as with a car you have 
to turn off 
the ignition before pulling out the key.Click the Start button, then click 
Shut  
Down.Do not press the power button to turn off your computer!  

 
After you have clicked Shut Down, your computer willbegina shut-
downprocess 
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in which it saves things you have been working on, and ends all 
programs that  
are running.You may see a window that says, “Windows is shutting 
down.”  
When the computer is done shutting down, the screenwill go black, and 
the 
computer tower will stop making any noise.It is now shut down.Itisnot 

necessary to press thepowerbutton—your computer will turn off 
automatically. 

 
Finding More Help 

 
If you ever find that you need help while using your computer,  
you can left-click 
theStart button, and then click “Help and Support.” 

In addition, most programs on your computer will also have an  
individual help feature.The Help function may be available from a 1.14 
Finding  
More Help 
Help menu at the top of thewindow, or by clickingaFig.  
 
button.Help buttons are usually located in the top- 
right corner of the window, and may look like a  
question mark.Help menus often have a search 18 
 
function or pre-prepared FAQs.Most programs also have 1-800 
numbers to 
connect with a technician. 
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Self-Check -1 

Written Test 

 
Directions:  Answer all the questions listedbelow. Use the Answer sheet provided in the next page: 

 
1. What process should be used to recall a document 

saved previously? (1 point) 
A. Copy 
B. Save 
C. Retrieve 
D. Enter 

 
 

2. What is most commonly used to enter text into a word 
processing program? (1 point) 

A. keyboard 
B. mouse 
C. printer 
D. monitor 

3. What happens when you press "Ctrl-Alt-Delete"? 

A. The computer will self-destruct. 

B. The program you are using will close. 

C. Your active window will close. 

D. The computer will restart. 

E. A menu of programs available on the computer will pop up on the desktop. 

4. How do you properly shut down a computer? 

A. Press the power switch on the front of the CPU to turn off the machine. 

B. Press the power button on the front of the monitor. 

 

C. Go to the "Start" button and select "Shut Down." 

D. Go to the "Start" button and select "Log Off." 
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E. Press the "Shut Down" key on the keyboard. 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Multiple Chose Test Answer  

1._________________ 

 

 

2._________________ 

 

 

3._________________ 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 2 points            Unsatisfactory - below 2 points  
You can ask you teacher for the copy of the correct answers. 
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2.1Drawing software 
is defined as a computer program for creating art on the computer. 
An example of drawing software is the Paint program on many computers. 
An example of drawing software are the computer-assisted drawing programs used by engineers 
and architects. 
 
Software design is the process by which an agent creates a specification of a software artifact, 
intended to accomplish goals, using a set of primitive components and subject to constraints.[1] 
Software design may refer to either "all the activity involved in conceptualizing, framing, 
implementing, commissioning, and ultimately modifying complex systems" or "the activity 
 
following requirements specification and before programming, as ... [in] a stylized software 
engineering process."[2] 
 
Software design usually involves problem solving and planning a software solution. This includes 
both a low-level component and algorithm design and a high-level, architecture design. 
software drawing is the process of envisioning and defining software solutions to one or more 
sets of problems. One of the main components of software design is the software requirements 
analysis (SRA). SRA is a part of the software development process that lists specifications used 
in software engineering. If the software is "semi-automated" or user centered, software design 
may involve user experience design yielding a storyboard to help determine those specifications. 
If the software is completely automated (meaning no user or user interface), a software design 
may be as simple as a flow chart or text describing a planned sequence of events. There are also 
semi-standard methods like Unified Modeling Language and Fundamental modeling concepts. In 
either case, some documentation of the plan is usually the product of the design. Furthermore, a 
software design may be platform-independent or platform-specific, depending upon the 
availability of the technology used for the design. 

 
The main difference between software analysis and design is that the output of a software 
analysis consists of smaller problems to solve. Additionally, the analysis should not be designed 
very differently across different team members or groups. In contrast, the design focuses on 
capabilities, and thus multiple designs for the same problem can and will exist. Depending on the 
environment, the design often varies, whether it is created from reliable frameworks or 
implemented with suitable design patterns. Design examples include operation systems, 
webpages, mobile devices or even the new cloud computing paradigm. 
 
Software design is both a process and a model. The design process is a sequence of steps that 
enables the designer to describe all aspects of the software for building. Creative skill, past 
experience, a sense of what makes "good" software, and an overall commitment to quality are 

 information Sheet-2 introduction to drawing software and drawing principle 
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examples of critical success factors for a competent design. It is important to note, however, that 
the design process is not always a straightforward procedure; the design model can be compared 
to an architect's plans for a house. It begins by representing the totality of the thing that is to be 
built (e.g., a three-dimensional rendering of the house); slowly, the thing is refined to provide 
guidance for constructing each detail (e.g., the plumbing lay). Similarly, the design model that is 
created for software provides a variety of different views of the computer software. Basic design 
principles enable the software engineer to navigate the design process. Davis[3] suggests a set 
of principles for software design, which have been adapted and extended in the following list: 
 
The design process should not suffer from "tunnel vision." A good designer should consider 
alternative approaches, judging each based on the requirements of the problem, the resources 
available to do the job. 
The design should be traceable to the analysis model. Because a single element of the design 
model can often be traced back to multiple requirements, it is necessary to have a means for 
tracking how requirements have been satisfied by the design model. 
The design should not reinvent the wheel. Systems are constructed using a set of design 
patterns, many of which have likely been encountered before. These patterns should always be 
chosen as an alternative to reinvention. Time is short and resources are limited; design time 
should be invested in representing (truly new) ideas by integrating patterns that already exist 
(when applicable). 
The design should "minimize the intellectual distance" between the software and the problem as 
it exists in the real world. That is, the structure of the software design should, whenever possible, 
mimic the structure of the problem domain. 
The design should exhibit uniformity and integration. A design is uniform if it appears fully 
coherent. In order to achieve this outcome, rules of style and format should be defined for a 
design team before design work begins. A design is integrated if care is taken in defining 
interfaces between design components. 
The design should be structured to accommodate change. The design concepts discussed in the 
next section enable a design to achieve this principle. 
The design should be structured to degrade gently, even when aberrant data, events, or 
operating conditions are encountered. Well-designed software should never "bomb"; it should be 
designed to accommodate unusual circumstances, and if it must terminate processing, it should 
do so in a graceful manner. 
Design is not coding, coding is not design. Even when detailed procedural designs are created 
for program components, the level of abstraction of the design model is higher than the source 
code. The only design decisions made at the coding level should address the small 
implementation details that enable the procedural design to be coded. 
The design should be assessed for quality as it is being created, not after the fact. A variety of 
design concepts and design measures are available to assist the designer in assessing quality 
throughout the development process. 
The design should be reviewed to minimize conceptual (semantic) errors. There is sometimes a 
tendency to focus on minutiae when the design is reviewed, missing the forest for the trees. A 
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design team should ensure that major conceptual elements of the design (omissions, ambiguity, 
inconsistency) have been addressed before worrying about the syntax of the design model. 

 
 
2.2 Introduction to CAD 
 
CAD (Computer Aided Design) is the use of computer software to design and document a 
product’s design process. 
 
Engineering drawing entails the use of graphical symbols such as points, lines, curves, planes 
and shapes.  Essentially, it gives detailed description about any component in a graphical form. 
 
Background 
 
Engineering drawings have been in use for more than 2000 years. However, the use of 
orthographic projections was formally introduced by the French mathematician Gaspard Monge 
in the eighteenth century. 
 
Since visual objects transcend languages, engineering drawings have evolved and become 
popular over the years. While earlier engineering drawings were handmade, studies have shown 
that engineering designs are quite complicated. A solution to many engineering problems 
requires a combination of organization, analysis, problem solving principles and a graphical 
representation of the problem. Objects in engineering are represented by a technical drawing 
(also called as drafting) that represents designs and specifications of the physical object and data 
relationships. Since a technical drawing is precise and communicates all information of the object 
clearly, it has to be precise. This is where CAD comes to the fore.  
 
CAD stands for Computer Aided Design. CAD is used to design, develop and optimize products. 
While it is very versatile, CAD is extensively used in the design of tools and equipment required 
in the manufacturing process as well as in the construction domain. CAD enables design 
engineers to layout and to develop their work on a computer screen, print and save it for future 
editing. 
 
When it was introduced first, CAD was not exactly an economic proposition because the 
machines at those times were very costly. The increasing computer power in the later part of the 
twentieth century, with the arrival of minicomputer and subsequently the microprocessor, has 
allowed engineers to use CAD files that are an accurate representation of the dimensions / 
properties of the object. 
 
Use of CAD 
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CAD is used to accomplish preliminary design and layouts, design details and calculations, 
creating 3-D models, creating and releasing drawings, as well as interfacing with analysis, 
marketing, manufacturing, and end-user personnel.  
 
CAD facilitates the manufacturing process by transferring detailed information about a product in 
an automated form that can be universally interpreted by trained personnel. It can be used to 
produce either two-dimensional or three-dimensional diagrams. The use of CAD software tools 
allow the object to be viewed from any angle, even from the inside looking out. One of the main 
advantages of a CAD drawing is that the editing is a fast process as compared to manual 
method. Apart from detailed engineering of 2D or 3D models, CAD is widely used from 
conceptual design and layout of products to definition of manufacturing of components. CAD 
reduces design time by allowing precise simulation rather than build and test physical prototypes. 
Integrating CAD with CAM (Computer Aided Manufacturing) streamlines the product 
development even more. 
 
CAD is currently widely used for industrial products, animated movies and other applications. A 
special printer or plotter is usually required for printing professional design renderings. CAD 
programs use either vector-based graphics or raster graphics that show how an object will look.  
 
CAD software enables 
 

Efficiency in the quality of design 
Increase in the Engineer’s productivity 
Improve record keeping through better documentation and communication 
Today, the use of CAD has permeated almost all industries. From aerospace, electronics to 
manufacturing, CAD is used in all industry verticals. Since CAD encourages creativity and 
speeds up productivity, it is becoming more and more useful as an important tool for 
visualization before actually implementing a manufacturing process. That is also one of the 
reasons CAD training is gaining more and more importance.  
 
2.2.1Types of CAD Software 
 
Since its introduction in late 1960’s, CAD software has improved by leaps and bounds.  A broad 
classification of CAD is: 
 
2D CAD 
3D CAD 
3D Wireframe and Surface Modeling 
Solid Modeling 
With more and more companies (if not all) turning to CAD / CAE / CAM to achieve efficiency, 
accuracy and reduced time-to-market of products, there is a growing demand for CAD software. 
The industry leaders in this space include AutoCAD, Assault Systems and Altair. 
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2.3 DRAWING PRINCIPLES: 

 
Balance – can be Symmetrical or Asymmetrical. 
Symmetrical = dividing a composition into two equal halves with seemingly identical elements 
on each side. 
 
Asymmetrical = balance based upon a visual sense of equilibrium that can be felt more than 
it can be measured. There are no specific rules for asymmetrical balance except that of 
diversity 
 
Repetition/Rhythm – a repeating visual element (line, shape, pattern, texture, movement); a 
flowing and regular occurrence. A subcategory of repetition is pattern. 
 
Pattern – any compositionally repeated element or regular repetition of a design or single 
shape; pattern drawing sin commercial art may serve as models for commercial imitation. 
Focus/Emphasis/Dominance – the prime center of visual importance within a composition to 
which all other visual elements yield; it holds the viewer’s attention because of its attractive 
and dominant influence on its surroundingsRule of Thirds – a compositional tool that makes 
use of the notion that the most interesting compositions are those in which the primary 
element is off center. Basically, take any frame of reference and divide it into thirds placing 
the elements of the composition on the lines in between. 
 
Visual Center – The visual center of any page is just slightly above and to the right of the 
actual (mathematical) center. This tends to be the natural placement of visual focus, and is 
also sometimes referred to as museum height. 
 
Golden Rectangle – Another method of arranging a composition. 
 
Unity/Harmony 
Scale – The overall size of an object 
 
Proportion – The relative size of different elements of an artwork. An example is the 
exaggerated proportions in caricatures. 
 
Contrast – When one extreme is pitted against another. Bright vs Dark. Heavy vs Light, 
Rough vs Soft, etc. 
 
Movement – How the artist leads the viewer’s eye around the page 
Depth – overlapping forms suggest depth; changes in scale can suggest depth; illusionistic 
perspective can suggest depth, atmospheric perspective (see images here) can suggest 
depth 
 
foreshortening also shows depth 
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OTHER IMPORTANT DEFINITIONS 
 
Picture plane – the size and shape of your paper/drawing surface. 
Closed composition – forms seem well contained by the edges of the picture plane 
Open composition – the imagery appears unrelated to the size/shape of the paper, creating 
an impression of extending beyond the picture plane 
Gestalt – “The sum of the whole is greater than its parts” is the idea behind the principle of 
gestalt. It’s the perception of a composition as a whole. While each of the individual parts 
have meaning on their own, taken together, the meaning may change. Our perception of the 
piece is based on our understanding of all the bits and pieces working in unison. 
Positive and Negative Space – 
 
 
Point of view – the position from which the composition is seen by the artist (eye level and 
distance from the subject) 
 
Composition exercise in class by John Ciampoli 
3D Design 

 
ELEMENT DEFINITIONS: 
 
Line: The edge of a shape or form or the direction followed by anything in motion. 
-Implied Line- is a line that doesn’t really exist, but appears to be present. 
-Actual Line- is a line that is actually present. 
 
Value: Shadows from lightness to darkness 
-Value variation gives a sense of space and depth to an object—emphasizing its three 
dimensionality. 
-Strong contrast in value can create emphasis. 
 
Color: Color is Light reflected from a surface. It can create emphasis, harmony, emotions, 
unity, and movement. 
-Color has three distinct qualities: 
1. Hue- color 
2. Value- lightness to darkness of a color 
3. Intensity- brightness to dullness of a color 
– mixing its complimentary color can dull intensity. 
 
Texture: Quality related closely to our sense of touch. It can create emphasis, movement, 
pattern, emotion. 
-Implied texture- is texture that appears to be present but it is an illusion. It is not really 
present. 
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-Actual texture- is texture that really exists and it can be felt. 
 
Shape: Shape encloses a two dimensional area. Shape can create most of the elements and 
many of the principles. 
-Types of shapes: Organic-curved edges, continuous Geometric-sharp edges, angles 
 
Form: Form encloses a volume or three-dimensional area. 
-Light and dark value variations and space are used to emphasize form. 
 
Space: Illusion of depth and space. 
-Ways to create space: 

 Overlapping — Shapes or forms in front of each other 

 Holes and cavities 
 
2.3.1PRINCIPLE DEFINITIONS: 
 
Balance: Refers to the equalization of elements in a work of art. 
-There are three kinds of balance: 

 symmetrical- formal, divided in half same 

 asymmetrical- informal, divided in half not same 

 radial- circular, design starts from center > out 
 
Unity/Harmony: Relates to the sense of oneness, wholeness, or order in a work of art. 
Combining similar colors, 
shapes, lines, textures, and patterns in an artwork can create harmony. Movement: Refers to 
the arrangement of parts in a work of art to create a slow to fast action of the eye. 
-Pattern, contrast, line can create this. 
 
Rhythm: It is a type of movement in an artwork or design often created by repeated objects. 
-There are different types of rhythm: 

o Regular-  

 Irregular-  
 
Emphasis: refers to placing greater attention to certain areas or objects in a piece of work. 
-Emphasis can be created through sudden and abrupt changes in opposing elements. 
(Example: bright yellow dot in large black area) 
 
Proportion: Refers to the relationship of certain elements to the whole and to each other. 
 
Pattern: is created by repetition of (not limited to) shape, line, color, or texture 
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Variety: It is achieved through diversity and change. Using different line types, colors, 
textures, shapes….. 
 
Gradation: Refers to a way of combining elements by using a series of gradual changes. 
-Examples of gradation: 
1. gradually from small shapes to large shapes 
2. gradually from a dark color to a light color 
3. gradually from shadow to highlight 
 

2.4 ELEMENTS OF DRAWING 

 
 Line – The way we treat our lines establishes a particular/dominant mood/emotion. 
 Shape – Flat, 2D aspects of form, as opposed to volume (think silhouette) 
 Value/Tone – Relative lightness or darkness 
 Texture – Can be actual or implied 
 Space – Positive space is the figure/object you’re drawing; Negative space is the area 

AROUND the figure object you’re drawing 
 Color – (we won’t use color in Beginning Drawing) 
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Self-Check -2 

 
                Written Test 

 
Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

1. Which of the following IS NOT drawing principles? 
A. Balance 
B. Pattern 
C. Unity/Harmony 
D. Space 

2. Which of the following IS TRUE ABOUTCAD 
(Computer Aided Design)  

A. is the use of computer software to design 
and document a product’s design process. 

B. symmetrical- formal, divided in half same 
C. asymmetrical- informal, divided in half not same 
D. radial- circular, design starts from center > out 

 
3. Which of the following IS NOT elements of 

drawing 

A. Line 
B. Shape 
C. Value 
D. All 

 
 

 

 

Answer Sheet 

 

 

 

 

Name:  _________________________             Date:  _______________ 

Multiple Chose Test Answer 

1._____________ 

2. ______________ 

3. _______________ 

 

 
 
 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 1.5 points            Unsatisfactory - below 1.5 points  
You can ask you teacher for the copy of the correct answers. 
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3.1 booting is the processof starting a computer. It can be initiated by hardware such as a button 

press, or by a software command. After it is switched on, a computer's central processing unit 
(CPU) has no software in its main memory, so some process must load software into memory 
before it can be executed. This may be done by hardware or firmware in the CPU, or by a separate 
processor in the computer system. 
 
Restarting a computer also is called rebooting, which can be "hard", e.g. after electrical power to 
the CPU is switched from off to on, or "soft", where the power is not cut. On some systems, a soft 
boot may optionally clear RAM to zero. Both hard and soft booting can be initiated by hardware 
such as a button press or by software command. Booting is complete when the operative runtime 
system, typically operating system and some applications is attained. 
 
The process of returning a computer from a state of hibernation or sleep does not involve booting. 
Minimally, some embedded systems do not require a noticeable boot sequence to begin 
functioning and when turned on may simply run operational programs that are stored in ROM. All 
computing systems are state machines, and a reboot may be the only method to return to a 
designated zero-state from an unintended, locked state. 
 
In addition to loading an operating system or stand-alone utility, the boot process can also load a 
storage dump program for diagnosing problems in an operating system. 
 
Boot is short for bootstrap[1][2] or bootstrap load and derives from the phrase to pull oneself up by 
one's bootstraps.[3][4][citation needed] The usage calls attention to the requirement that, if most 
software is loaded onto a computer by other software already running on the computer, some 
mechanism must exist to load the initial software onto the computer.[5] Early computers used a 
variety of ad-hoc methods to get a small program into memory to solve this problem. The invention 
of read-only memory (ROM) of various types solved this paradox by allowing computers to be 
shipped with a start up program that could not be erased. Growth in the capacity of ROM has 
allowed ever more elaborate start up procedures to be implemented. 

 
3.2 How to install AutoCAD 2007  
 

Obtain your purchased copy of the Longbow Converter here Start the Longbow Converter tool 
Insert your AutoCAD 2007 CD into your CD-ROM drive select the 2nd tab named “Old 
AutoCAD Installer Reviver“ Using the “…” button, path the to your AutoCAD 2007 CD Click 
“Run Old Installer “Read and follow all the prompts 

Once the AutoCAD 2007 setup starts, stop and read the next step… 

In the setup program, navigate through each setup dialog as normal, with these 

Information Sheet-3 
booting the CAD software  
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exceptions…When you click the Install link from your setup you may see a dialog box appear 
saying – “This program has compatibility issues” – simply check the “Don’t show this message 
again” and then click the “Run the program without getting help” button When you arrive at the 
installation folder path setup dialog, **it’s vitally important to make sure you install to 
c:\acad2007 (not Program Files (x86)\AutoCAD 2007)**. 

Once AutoCAD has installed, completely close setup Now go back to the Converter app and 
make sure it’s completed the final stage of processing using the “Old AutoCAD Program 
Reviver” tab Finally, reboot your PC and run your AutoCAD as normal 

NOTE: When starting AutoCAD, if you see a warning dialog when you run saying “This program 
has known compatibility issues”, simply click “Don’t show this message again” and then click 
“Run the Program…” 

Installing AutoCAD 2007 Sp1 

 

3.3Starting AutoCAD 

Complete Reference / AutoCAD: TCR / Cohn / 222429-0 / Chapter 1 

This chapter assumes that you have already installed AutoCAD. If you are going to 

work in AutoCAD as you follow along in this book, you should install AutoCAD now, 

before proceeding. Installing AutoCAD 2007 is quite simple, particularly compared to 

earlier versions of the program. An easy-to-use Setup program guides you through 

the AutoCAD installation process, transferring the files from the CD-ROM to a folder 

it creates on your hard disk. The Setup program also creates a menu item on the 

Windows Start menu, and a shortcut icon on your desktop. If you need additional help 

installing AutoCAD, see Appendix C. 

P:\010Comp\CompRef8\429-0\ch01.vp 

Monday, April 08, 2007 5:05:37 PM 

Color profile: Generic CMYK printer profile 

Composite  Default screen 

You can start AutoCAD by choosing it in the Start menu or by double-clicking the 

AutoCAD 2007 icon on the Windows desktop. To start AutoCAD from the Start menu, 

choose Start | Programs | AutoCAD 2007 | AutoCAD 2007. 

The first time you start AutoCAD, the program displays the Authorization wizard, in 

which you provide the authorization code to unlock your copy of AutoCAD. You register 

your copy of AutoCAD and obtain this authorization code from Autodesk, either via the 

Web or by e-mail, phone, fax, or mail. If you elect to authorize AutoCAD at this time, the 

wizard guides you through the process, offering options such as connecting to Autodesk’s 

registration web site, automatically generating an e-mail message, displaying the proper 

phone numbers, or printing a registration form that you can fax or mail to Autodesk. If 

you decide to defer this process until a later time, you can begin using AutoCAD now. 

You have 15 days from the first time you start AutoCAD in which to register and 
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authorize your copy. The Authorization wizard appears every time you start AutoCAD 

until you have registered your copy and obtained your authorization code. Once you 

obtain the code, write it down and save it along with your AutoCAD 2007 CD-ROM, 

in case you ever need to reinstall the software. 

When you start AutoCAD, the program displays the AutoCAD 2007 Today 

window. This window provides tools to help you start a new drawing, load symbol 

libraries, access an online bulletin board for design collaboration within your company, 

and use the Autodesk Point A design portal. You’ll learn more about this window 

later in this chapter (see Figure 1-17). For now, click the Close button to dismiss the 

AutoCAD 2007 Today window. 

The AutoCAD 2007 Today window serves as the default startup dialog box whenever you 

start AutoCAD or begin a new drawing. If you prefer, you can reconfigure AutoCAD to 

use a more traditional style startup dialog box, similar to the one used in earlier versions, 

by changing the Startup setting on the System tab of the Options dialog box 

 

3.4Open Existing Drawings 

 

1.     Choose                   File, OPEN. 

or 

2. Press CTRL + O. 

  or 

3. Click the OPEN icon. 

  or 

4. Type OPEN at the command prompt. 

  Command: OPEN 

5. Press ENTER 

6. Double Click the desired directory to find the drawing to 
open. 

7. Click the drawing name to open. 

8. Click The OK button. 

 

 

-Preview shows a bitmap image of the drawing selected. This 
image is the view that was last saved in the drawing. It will not 
show a preview of drawings saved before R13 AutoCAD. 
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Self-Check -3 

 
                Written Test 

 
Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 
page: 
 
1. _________________is the processof starting a computer. 
       A. AutoCAD 2007                               C. booting 
       B. Compass                              D. Options dialog box 
 
2. Which one Explain Starting AutoCAD 

 
A. double-clicking the AutoCAD 2007 icon on the Windows desktop 
B. Close button to dismiss 
C. appears every time you start 
D. All 

 
 
 
Answer Sheet 
 
 
 
 
Name:  _________________________             Date:  _______________ 
Multiple Chose Test Answer 
1._____________________________2._______________________________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 1.5 points            Unsatisfactory - below 1.5 points  
You can ask you teacher for the copy of the correct answers. 
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4.1 Screen display areas 
is the physical size of the area where pictures and videos are displayed. The size of a screen is 
usually described by the length of its diagonal, which is the distance between opposite corners, 
usually in inches. It is also sometimes called the physical image size to distinguish it from the 
"logical image size," which describes a screen's display resolution and is measured in pixels 
4.1.1Getting Familiar with the AutoCAD User Interface 

Before you can start drawing you need to get familiar with the AutoCAD window. The window 

below is called AutoCAD User Interface.  

 

  

 

 

 

 

 

 

 

 

 

 

 

  

 

 

Fig. 4.1 the AutoCAD User Interface 

1, DRAWING AREA 

Location: The large area in the center of the screen.  

Information Sheet-4 
Screen display areas 
and  basic parameters 

https://en.wikipedia.org/wiki/Diagonal
https://en.wikipedia.org/wiki/Display_resolution
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This is where you will draw. This area represents a piece of paper. The color of this area can be 

changed using Tools / Option / Display / Color. The default color for 2007 is white. 

 

2. CROSSHAIRS / CURSOR 

Location: Can be anywhere in the Drawing Area. 

The movement of the cursor is controlled by the movement of the pointing device such as a 

mouse. You will use the cursor to locate points, make selections and draw objects. The size can be 

changed using Tools / Options / Display / Crosshair Size. 

 

3. COMMAND LINE 

Location: The three lines at the bottom of the screen. 

This is where you enter commands and AutoCAD will prompt you to input information. 

4. COORDINATE DISPLAY (F6) 

Location: Lower left corner 

In the Absolute mode (coords = 1): displays the location of the crosshairs / cursor in reference to 

the Origin. The first number represents the horizontal movement (X-axis), the second number 

represents the vertical movement (Y-axis) and the third number is the Zaxis which is used for 3D. 

In the Relative Polar mode (coords = 2): displays the distance and angle of the cursor from the 

last point entered. (Distance<Angle) 

 

5. STATUS BAR 

Location: Below the Command Line. 

Displays your current settings. These settings can be turned on and off by clicking on the word 

(Snap, Grid, Ortho, etc.) or by pressing the function keys, F1, F2, etc. See button descriptions 

below. 

 

[SNAP] (F9) 
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Increment Snap controls the movement of the cursor. If it is off, the cursor will move smoothly. If it 

is ON, the cursor will jump in an incremental movement. The increment spacing can be changed at 

any time using Tools / Drafting Settings/ Snap and Grid. The default spacing is .250. 

 

 [GRID] (F7) 

The grid (dots) is merely a visual "drawing aid". The default spacing is 1 unit. You may change the 

grid spacing at any time using: Tools / Drafting Settings /Snap and Grid. 

 

 [ORTHO] (F8) 

When Ortho is ON, cursor movement is restricted to horizontal or vertical. When Ortho is OFF, the 

cursor moves freely. 

 

 [POLAR] (F10) 

POLAR TRACKING creates “Alignment Paths” at specified angles. 

 [OSNAP] (F3) 

RUNNING OBJECT SNAP 

Specific Object Snaps can be set to stay active until you turn them off. 

 [OTRACK] (F11) 

OBJECT SNAP TRACKING Creates “Alignment Paths” at precise positions using object snap 

locations. 

 [LWT] 

LINEWEIGHT. Displays the width assigned to each object.  

MODEL 

Switches your drawing between paper space and model space. 

6. UCS ICON (User Coordinate System) 

Location: Lower left corner of the screen. The UCS icon indicates the location of the 

Origin. The UCS icon appearance can be changed using: View / Display / Icon / Properties. 

7. ORIGIN 

The location where the X, Y and Z axes intersect. 0,0,0 



  

    
 
 

 
Page 35 of 167 
 

Federal TVET 
Agency 
Author/Copyright  

TVET program titleROAD CIVIL 
WORKS    

Version -1 
October 2019 

 
 
 

FUNCTION KEYS 

o F1  Help Explanations of Commands. 

o F2  Flip screen Toggles from Text Screen to Graphics Screen. 

o F3  Osnap Toggles Osnap On and Off. 

o F4  Tablet Toggles the Tablet On and Off. 

o F5  Is plane Changes the is plane from Top to Right to Left. 

o F6  Coordinate Display Changes the display from ON / Off /. 

o F7  Grid Toggles the Grid On or Off. 

o F8  Ortho Toggles Ortho On or Off. 

o F9  Snap Toggles Increment Snap on or off. 

o F10  Polar Toggles Polar Tracking On or Off. 

o F11  Otrack Toggles Object Snap Tracking On and Off. 

4.2 SPECIAL KEY FUNCTIONS 

 Escape Key Cancels the current command, menu or Dialog Box. 

 Enter Key Ends a command, or will repeat the previous command if the command line is  

blank. 

 Space Bar Same as the Enter Key, except when entering text. 

 Pull-down “menu bar” 

(1) The pull-down “MENU BAR” is located at the top of the screen. 

 

 

By selecting any of the words in the MENU BAR, a (2) Pull-down menu appears. If you select a 

word from the pull-down menu that has an (3) Arrow, a (4) Sub Menu will appear. (Example: Draw 

/ Circle). If you select a word with (5) Ellipsis ... , a dialog box will appear. (Example: Draw / 

Boundary…) 
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 Fig. 4.2 the AutoCAD User Interface 

 

 Dialog Box 

Many commands have multiple options and require you to make selections. These commands 

will display a dialog box. Dialog boxes, such as the Hatch dialog box shown here, make selecting 

and setting options easy. 

 

 

 

 

 

 

 Fig. 4.3 Dialog Box 
 

 

Toolbars 
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Fig. 4.4 the Toolbars 

 

AutoCAD provides several toolbars to access frequently used commands. 

 

The (1) Standard, (2) Object Properties, (3) Draw, and (4) Modify toolbars are displayed by 

default. Toolbars contain icon buttons (5).These icon buttons can be selected to Draw or Edit 

objects and manage files. If you place the pointer on any icon and wait a second, a tool tip (6) will 

appear and a help message (7) will appear at the bottom of the screen. Toolbars can be “floated” 

or “docked”. Floating toolbars (8) move freely in the drawing area and can be resized. To move, 

place the pointer on the toolbar title then hold the left mouse button down, drag to the new location 

and release the mouse button. To resize, place the pointer on the right or bottom edge of the 

toolbar. When the pointer changes to a double ended arrow, hold the left mouse button down and 

drag. When desired size is achieved, release the mouse button. Docked toolbars (9) are locked 
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into place along the top, bottom or sides of the AutoCAD Window. To dock, place the pointer on 

the toolbar title, hold the left mouse button down and drag to the top, bottom, or either side of the 

AutoCAD window. When the outline of the toolbar appears, release the mouse button 

Open or Close Toolbars 

Many other toolbars are available by selecting View / Toolbars from the Pull-down menu. Select 

the “Toolbars” tab. A list of available toolbars will appear. (A check mark indicates the toolbars that 

are “open”.) 

 

 

 

 

 

 Fig. 4.5 Open or Close Toolbars 

 Palettes 

There are two types of Palettes within AutoCAD. The first type has been pre-designed by 

AutoCAD. An example of a pre-designed palette would be the Properties Palette shown below. 

This palette will appear automatically when you select the Properties command. The second type 

is a customizable Palette that you may create to hold frequently used commands, hatch patterns, 

symbols, etc. (Customizing is in the Advanced Workbook) Palettes may be resized and moved to 

any location on the screen. They can be docked or float. The Auto-Hide function allows you to 

collapse the palette when the cursor is away from the palette. When you move the cursor over the 

Title Bar the Palette will reappear. 
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4.3Opening/ Saving/ Exiting the Files 

 Saving the template file                                             Fig. 4.6Palettes 
1. Left-click Save As … in the File drop-down menu or the Save icon in the Quick Access 

Toolbar . 

2. In the Save Drawing As dialog which comes on screen ( Fig. 4.21 ), click the arrow to the 

right of the Files of type fi eld and in the pop-up list associated with the fi eldclickon AutoCAD 

Drawing Template (*.dwt) . The list of template fi les in the AutoCAD 2009/Template 

directory appears in the fi le list. 
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Fig. 4.7Saving the template to the name a cadiso.dwt 

 

Fig. 4.8 The Template Description dialog 

The template can now save to be opened for the construction of drawings as needed. 

Now when AutoCAD 2009 is opened again the template acadiso.dwtappears on screen. 
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Fig. 4.8 exiting command 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ZOOM COMMANDS 
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Fig. 4.9 ZOOM COMMANDS 
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4.4Undo  and Redo 
 

 
 

Reversesthelastaction. 
 

1. ChooseEdit,Undo. or 

2. Click  the Undo icon. or 
 

3.    PressCTRL+Z. 
 

4.    Type U at the command prompttoundothelastcommand. 
 

Command:U 

Redo 
 
 

Reverses the effects of a single UNDO or U command. 

1. ChooseEdit, Redo. or 

2. ClicktheRedoicon.  or 

3.      TypeREDOatthecommandprompt toredothelastundocommand. 
 

Command:REDO 
 

TIPS: 
 

-UNDO has no effect on some commands and system variables, including those that 

open, close, orsave a window or a drawing, display information, 

changethegraphicsdisplay,regeneratethe drawing, or export the drawing in a 

different format. 
 

 
 
-REDOmustimmediatelyfollowtheUorUNDOcommand 
 

 

 

 

 

DRAW TOOLS  

The majority of tools in AutoCAD 2009 can be called into use by any one of the following five 

methods: 
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1. Placing the cursor on the tool’s icon in the appropriate panel. Figure 3.2 shows the 

Polygon tool selected from the Home/Draw panel; 

2. With a click on the tool’s name in a toolbar. Figure 3.3 shows the Draw toolbar. 

Placing the cursor on the Polygon tool icon in this toolbarshows the same tooltip as 

that shown in Fig. 3.2 ; 

3. byclickingon the tool’s name in an appropriate drop-down menu. Figure 3.4 shows the 

tool names and icons displayed in the Draw dropdown menu. It is necessary to fi rst 

bring the menu bar to screen with a click on Show Menu Bar in the right-click menu of 

the Quick Access Toolbar ( Fig. 3.1 ); 

 

Fig. 3.1 bringing the menu bar on screen 

 

Fig. 4.10The Polygon tool and its tooltip selected from the Home / Draw panel 
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     Fig. 3.3 The tool icons in the D raw toolbar 

 

Fig. 4.11the D raw drop-down menu 
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4. by enteringan abbreviation for the tool name at the command line in the command palette. For 

example the abbreviation for the Line tool is l , for the Polyline tool it is pland for the Circle 

tool it is c ; 

5. by enteringthe full name of the tool at the command line. 

In practice, operators constructing drawings in AutoCAD 2009 may well use a combination of these 

five methods. 

 

1.5 Basic parameters 

The Basic Parameters rollouts for Standard materials contain controls that let you set the color of 

your material, the shininess, the transparency, and so on, and specify maps to use for the various 

components of the material 

The first part of the Basic Parameters rollout contains controls for overall material components. 

They are described in the following topics: 

 

Color Controls let you choose the material’s color components, or replace them with maps. 

Self-Illumination makes a material appear lit from within. 

Self-illumination is not available for the Strauss shader. 

Opacity controls how opaque or transparent a material is. 

Diffuse Level controls the brightness of the diffuse color component. 

Diffuse Level is available only for the Anisotropic, Multi-Layer, and Oren-layer-Blind shades 

Roughness controls how quickly the diffuse component blends into the ambient component. 

Roughness is available only for the Multi-Layer. 
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Now that you've learned a lot of the drawing and modifying commands, it's time to go to the next 

level. This lesson will introduce you to text, dimensioning and the concept of layers. What you will 

do is take one of your previous assignments, save it to a new name and then add text and 

dimensions to it. These are the commands you'll be learning. 

 

Command Keystroke Icon Menu Result 

Layer  Layer / LA  

 

Format >Layer Starts the Layer 

and Linetype 

property dialog 

box 

Text  Text No 

Icon  

Draw > Single 

Line Text 

Creates a 

single line of 

text 

Dimension Dim Many  Dimension > 

(pick one) 

Dimensions 

previously 

drawn objects 

Scale Scale / SC 

 

Modify > Scale Proportionately 

resizes (or 

scales) objects 

Fig. 4.12 LAYERING 

 The first thing you want to do is create three layers. Layers are used to organize drawings. 

Imagine a large project for a high-rise tower. The designers would create layers for the 

electrical, plumbing, landscape and more. It is necessary to control the drawing and turn 

some layers off and view only the ones you want. This is one reason why layers are 

needed.  

 



  

    
 
 

 
Page 48 of 167 
 

Federal TVET 
Agency 
Author/Copyright  

TVET program titleROAD CIVIL 
WORKS    

Version -1 
October 2019 

 
 
 

 You will be creating a layer for the dimensions, one for the lines (objects that were drawn) 

and another for the text. Start the LAYER command (LA). This will bring up the Layer 

Properties Manager (shown below). We'll cover the things that are used most often in this 

lesson.  

 

Fig. 4.12This will bring up the Layer 

 Looking at the Dialog Box, you will see a lot of information. Notice the button beside Make 

Current on it. Below it is the name of the current layer you are drawing on. The main 

window gives you information about each particular layer. At this point, you want to be 

concerned with the 'Name', 'On' (light bulb) and 'Color' (colored square) columns as well as 

the 'New' button.  

More about Layers  

In the Layer Properties Manager, you will notice that each layer can have a number of specific 

properties.  
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Fig. 4.12 This will bring up the Layer 

 Status: Displays the current state of the layer. In this example, the green check means that 

Objects is the current layer. 

 Name: The name of the layer. Give layers understandable names. 

 On: If a layer is 'On' it means that it is visible (but objects can still be erased when the 

'Select > All option is used). 

 Freeze: A layer is not visible and cannot be deleted. 

 Lock: Layer is visible, but cannot be modified. 

 Color: A specific color for everything on that layer. 

 Line type: A specific line type (hidden, center, etc) for the layer. 

 Line weight: The visible width of the objects on that layer. 
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Self-Check -4 

 
                Written Test 

 
 
Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 
page: 
 

1. One of the following commands is used to return the current deleted drawing /object/. 

a. Undo  

b. Redo 

c. zoom  

d. Save 

2. Which one of the following command is used to stored the prepared drawing.  

a. Save  

b. Move  

c. Undo  

d. Zoom 

3. The toolbar at the top of the AutoCAD 2008 window is: 

 (a) The Draw toolbar 

 (b) The Modify toolbar  

(c) The Standard toolbar  

(d) The Properties toolbar  

4. The Design Center palette can be opened from the: 

 (a)  Layer toolbar (b) Properties toolbar  

(c) Modify toolbar (d) Standard toolbar  

5. Press the F9 key of the keyboard for: 

 (a) Grid on/off  

(b) Snap on/off  
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(c) Ortho on/off 

 (d) Osnap on/off 

   
 
 
 
 
Answer Sheet 
 
 
 
 
Name:  _________________________             Date:  _______________ 
Multiple Chose Test Answer  
 
1.____________________________2_______________________________ 
3_____________________________4_______________________________ 

 
Reference  
• Prepared by Kathleen Lockhart 
• http://www.clker.com/clipart-1912.html 
• http://www.psdgraphics.com/psd-icons/psd-mouse-cursor-and- 
hand-pointer-icons/ 
• http://weblogs.asp.net/sfeldman/archive/2012/09/10/windows-8- 
start-menu-button.aspx 
• http://en.wikipedia.org/wiki/Computer_file 
• https://www.google.com/search?q=computer&ie=utf-8&oe=utf- 
8&aq=t&rls=org.mozilla:en-US:official&client=firefox- 
a&channel=fflb#hl=en&client=firefox-a&hs=KOS&rls=org.mozilla:en- 
US:official&channel=fflb&q=computer&tbs=dfn:1&tbo=u&sa=X&ei= 
5cFXUPuFILOEygGf1YC4DQ&ved=0CBwQkQ4&bav=on.2,or.r_gc.r_pw 
.r_qf.&fp=2f3cf7745a05d274&biw=1366&bih=620 

 
 
 
 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 1.5 points            Unsatisfactory - below 1.5 points  
You can ask you teacher for the copy of the correct answers. 
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Instruction Sheet Learning Guide #16 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics: 

 Creating and guiding  Basic CAD drawings 

 Prepare standard Drawings  

 reviewing CAD drawings 

 

This guide will also assist you to attain the learning outcome stated in the cover page. Specifically, 

upon completion of this Learning Guide, you will be able to: 

 Create and guide Basic CAD drawings are is sought as required. 

 prepare Drawings are in accordance with standard operating procedures. 

 review As required, CAD drawings are with supervisor and/or other designated staff 

in accordance with company procedures 

 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 41.  

3. Read the information written in the information “Sheet 1, Sheet 2, and Sheet  

4. Accomplish the “Self-check 1,Self-check t 2, and Self-check 3” in page 65, 74, and 

101respectively.  

5. If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation Sheet 1, 

Operation Sheet 2 and Operation Sheet 3 ” in page -75,51,63,and 85 

6. Do the “LAP test” in page – 102 (if you are ready). 
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1.1 CAD standards matter. We are aware of this. Yet so few of us have taken the time to develop, 
document, and deploy the CAD standards we desperately need. We have the best intentions — we 
say we will “get to it when things slow down.” But it just doesn’t happen. The reason is simple —
 developing CAD standards is hard work. 
 
Never fear. This article gives you the skills to confidently create a full set of CAD standards and help 
your team of CAD professionals be their best. It outlines the process of installing CAD standards in 
your company, including knowing when it’s right for you to create standards and identifying which 
standards are needed. CAD managers, coordinators, and office leaders: learn tried-and-true steps 
that everyone can put to use, regardless of how busy you are. Looking for an overview of the 
process? Check out the related article, "The Stages of Developing CAD Standards." 
 
Start at the Beginning 
It may seem like an obvious thing to say, “We begin at the beginning,” but exactly where is “the 
beginning”? Some firms feel that CAD standards rest entirely on the integrity of the DWG and 
therefore “the beginning” is a point in the drawing. Other believe that a valid standard revolves 
around the proper application of company processes and therefore work should start with a 
collection of Best Practice documents. 
 
While both of these approaches are valid, I feel there are only one logical way to begin at “the 
beginning” and it is not in the drawing or in best practice documents. I believe that the beginning is 
a point that can only be identified by communicating with a firm’s CAD leaders. 
 
Ask the Tough Questions 
Taking time in the beginning to meet with as many available leaders of a firm’s CAD staff is a 
fantastic starting point for your CAD standard creation efforts. However, while it may be instinctive 
to meet and discuss the new standard, I recommend these initial meetings revolve around current 
efforts. Specifically, I think that only by having open communications with CAD leaders can you 
properly identify the pain points of the current CAD production process. You must meet with the 
people doing the work to find out what does not work. 
 
Once you have met with the full range of available CAD leaders in your firm and identified a wide 
collection of pain points you have the beginnings of a road map to your new CAD standard. These 
are the high points that require immediate, or added, attention in the creation process. 
 
Distilling this information will allow you to identify the single greatest pain point that is hindering 
production for your CAD staff. This is an ideal point to refer to as “the beginning.” But, just a bit 
more reflection is required before you can begin work. 

Information Sheet-1 Creating and guiding Basic CAD 
drawings 
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What's Beneath “the Beginning”? 
For the sake of this example let’s set a hypothetical situation in which you have determined that a 
common difficulty in your firm is time wasted due to plots with incorrect line weights. You may have 
decided that the starting point for your CAD standard is the following: 
 
“Standardize plot styles and practices to produce identical plan set plots.” 
 
While this is a very valid thought, you must take a moment to think whether or not plot styles are in 
fact the cause of lost time. In researching DWG files, you may learn that the actual cause has 
nothing to do with plot styles, but rather with the colors associated with entities. This could lead to 
the secondary assumption that “layering standards” are an ideal starting point. However, further 
examination of several representative projects could determine that while layer configurations are 
consistent with an existing drawing template, your CAD staff has been modifying individual entities 
to change the color “by object” rather than “by layer.” This revelation points to an entirely different 
starting point for your standard, that being a “best practice” issue. 
 
This single example is just one way in which research, reflection, and further examination is 
absolutely necessary in order to best determine the actual cause of an inefficiency. 
 
Considering the myriad of aspects that could comprise your new CAD standard, it quickly becomes 
obvious that this communication and examination is essential to the return on investment in the 
development process. Without this initial hashing and analysis, it is incredibly easy to become 
derailed and focus effort, and costs, on areas of a CAD standard that will yield reduced, or 
ineffective, results. 
 
Take the time to properly identify the areas of your new standard that will yield the greatest impact 
in the shortest amount of time! 
 
The First Milestone 
If you have properly identified your first pain point of production, then you are at a very enviable 
stage where you can confidently report to your management, or supporters, the following: 
 
A full listing of management stakeholders who will oversee what aspects of the new standard 
A wide list of areas that require focus in the development of your standard 
A general breakdown, or roadmap, of how your standard will be developed so initial efforts have the 
greatest impact 
The area identified as the cause of the greatest hindrance to CAD production 
This report to your stakeholders marks your first milestone and cements the effort to properly begin 
the process of creating a new CAD standard for your organization. It is also a major step in building 
confidence in your stakeholders that the efforts to develop a new standard are not aimless or 
misguided. Once apprised of your progress, your stakeholders may have input to add. Once 
everyone aware of the direction the work is going, it is time to move on. 
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Beyond the Beginning 
Due to the nearly endless aspects of CAD work, and therefore CAD standards, it would be 
impossible to identify ALL the possible directions that a new CAD standard can go. The possibilities 
are almost infinite. In addition, I feel that any person selected as the coordinator of an organization’s 
standard should have extensive CAD experience from which they can draw on to know the minutia 
making changes such as layer color in order to set up an ideal drawing. 
 
That being said, there is no reason that a helpful (but by no means “complete”) list of possible items 
to include might not be helpful! The following is a list of the most common items included in general 
CAD standards and therefore will probably show up on your roadmap to a new standard: 
 
File Structure — Too many organizations do not take the structure and integrity of their data 
seriously enough. A standard file structure for CAD drawings that categorizes existing, proposed, 
survey, and record drawing files is essential. This reduces the time it takes to find needed files. This 
is especially true after long periods of time pass between project phases. 
File Naming Standard — A standard convention for CAD naming is essentially to easily and 
confidently identify drawings in large drawing sets. Mistakenly opened drawings files require 
rendering time to initially “open,” and that time does add up! Remember, time is money! 
Layering Standard — Layering is essential to drawing files, both large and small. Establishing 
conventions for nomenclature, color, and visibility are just a few ways to create a standard that can 
be relied on throughout your organization. And do not forget the layer descriptions! 
Annotation Standard — Codifying the specifics of text in drawings is essential to the continuity of a 
plan set. Plan sheets with varied font styles, orientations, colors, dimension styles, and leader 
callouts rob your organization of the professional impression it deserves! 
External Reference Standard — While external references and data shortcuts can be huge 
timesavers, improperly applying them could cause issues. The most common issue being “circular 
references” in which external references have multiple, nested, entries in a single drawing file. 
Establishing a best practice of inserting external references as “overlay” objects is a quick and 
reliable fix. 
Plot Standard — No matter how detailed and thorough a drawing file may be, until it is shared with 
building or manufacturing professionals it is just so many lines on a screen. Since most plan sets 
are still shared in print, it is very important that any organization have a single or standardized set of 
plot files that can be relied on to accurately produce reliable and prints with accurate lineweights 
and colors. 
Again, this is by no means a complete list. Nor is it a detailed direction of “how to change layer 
colors” or other minutia. The wealth and depth of information on the Internet and in resources 
available for purchase more than covers those deep, detail needs. 
 
The Shape of Standards 
Since a CAD standard has a variety of aspects that require attention and different approaches, it 
only makes sense that the standard itself would be comprised of various forms of documentation. 
These can take several forms that include: 
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Drawing Templates — “Seed” files that are used to set initial, standardized configurations, of CAD 
drawings that speed production 
Best Practice Documents — Written documents that catalog and detail an organization’s approved 
method for CAD production 
Detail Libraries — Standardized, reusable CAD drawings that represent water, paving, structural, 
and other design details that are used across multiple projects for greater design information 
Drawing Templates 
Drawing templates are CAD drawing files that end in the file extension “DWT” and are used to store 
preferred settings for DWG files. When beginning a new DWG file, a template can be selected as a 
“seed” that AutoCAD and other CAD products will use to create a new file with all of the DWTs pre-
defined aspects. These can include layer standards, plot configurations, annotation styles, and 
many other details. 
 
Obviously this can be a great time saver, but more importantly it creates a method of standardizing 
these drawing features with little to no effort. Therefore, DWT files are essential for inclusion in any 
CAD standard. 
 
As fantastically helpful as the DWT file can be, it does not have to be difficult to create. The process 
is as simple as taking a drawing based on the existing DWT in use, making the desired changes, 
and saving the file as a “Drawing Template” for future use. 
 
Once created, drawing templates should be stored in a designated location accessible to all 
production CAD staff. This highlights the importance of document file locations and file structures so 
all involved parties can be confident that they can find the needed template. A template that can’t be 
found won’t be used! 
 
Best Practice Documents 
Along with drawing templates, best practice documents are essential to the successful creation of 
any CAD standard. It is not enough to “set things up” if you do not properly document the steps 
involved in the approved production process for an organization. 
 
Essentially, a “best practice” is a well-thought-out “how to” document. It should take a single 
process and distill it into the individual steps required to take the selected task from beginning to 
end. 
 
Best practice documentation can take the form of something as simple as a bullet list of steps, 
consisting of just a few words each. However, truly effective documents will present a single task in 
a way that explains not only the steps involved in the process, but also its concepts. In addition, the 
process information should be presented in a manner that is equally useful for both novice and 
experienced production staff. 
 
The best practice example presents a sample document that has sections that explain the concept, 
the step-by-step process, a checklist, and a workflow diagram. While more effort is required for this 
type of approach, such a document is universally applicable for both new and experienced users. 



  

    
 
 

 
Page 58 of 167 
 

Federal TVET 
Agency 
Author/Copyright  

TVET program titleROAD CIVIL 
WORKS    

Version -1 
October 2019 

 
 
 

The result is that, when correctly, a best practice document should only have to be created once, 
then maintained routinely. The cost savings should be obvious to anyone questioning time spent 
creating these assets. 
 
Detail Libraries 
Standardized detail libraries, in addition to drawing templates and best practice documents, are key 
to the success of any nascent CAD standard. This single, simple innovation in your production 
practice can yield a massive return on investment in terms of wasted billable hours, resulting in 
increased effectiveness for your team. 
 
The reason it is necessary to create a standardized detail library which is, in turn, made available to 
all production staff is a matter of multiplication, rather than simplification. If a company has even the 
simplest detail, for example a fire hydrant, and has 10 offices then there is a strong likelihood of 
duplicated effort. Why would anyone reinvent the wheel, let alone do it 10 times? Even if the 
duplicated effort were assumed to be half, that is still 4x the additional billable hours to recreate a 
single detail. 
 
Now multiply that wasted time by the number of details in any given design firm. The scope of 
wasted time quickly becomes staggering. Still, the waste does not end there. The practice of 
maintaining multiple instances of detail drawings creates an ecosystem that all but guarantees 
errors in maintenance. Multiple instances of details that differ from one another are not very 
standard. Standardizing the full set of details across all office locations is the only sure way to put 
an end to all of this waste. 
 
As with most aspects of any CAD standard, the exact details of how you choose to organize the 
detail library for your organization will vary. However, there are some basic steps involved with 
standardizing any existing collection of CAD details: 
 
Collect all multiple instances of existing details 
Review the full collection and select the best, most suitable file 
Check the line work 
Eliminate duplicate line work 
Convert connected lines into single polylines 
Check hatches 
Check the text 
Check font styles and sizes 
Convert all existing text to Mtext and spell check 
Check all callouts and dimensions for accuracy 
Verify layering 
Verify justification 
Check the layers 
Reduce existing layers to bare minimum 
Normalize layer settings and nomenclature 
Enter layer descriptions 
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Check the detail’s insertion point 
By following the above checklist, you can quickly reduce the intimidation factor of such a daunting 
task. Soon you will have a collection of similarly formatted detail drawings that will work in your 
projects. 
 
As a final tip, examine the physical size of the detail in relation to the intended sheet size and adjust 
the size accordingly to insure it will fit with the standard border in use. Also, I deeply recommend a 
separate title block with a detail grid to avoid cluttered detail sheets. This grid should have 
standardized spacing for details and all details should be set to fit into one or more grid spaces, but 
never more than one detail per space. 
 
Deploying the CAD Standard 
Whatever route and specifics you choose to follow in the quest to develop a CAD standard for your 
organization, eventually there comes a time to release the standard into the wild. And to do that, 
you need to have a plan. 
 
The Deployment “Meta-Standard” 
But first, you should be prepared to document the process that you follow to release your standard. 
Think of this as either a best practice, or a “meta-standard” for releasing standards. 
 
Your release process, or best practice, does not have to be elaborate. In fact, a single page, or 
electronic document could satisfy your entire need here. Naturally, the more detail that is included, 
the better. Still, since this best practice is intended only for your own use, being sparse is 
acceptable. 
 
Things to document in your deployment notes include: 
 
Server directory location(s) to be deployed to or updated 
Necessary support paths to be added to workstation installations 
List of deployed standards and / or detail libraries 
Last update date 
Contact information for CAD leaders to be notified on updates 
Any special log-in credential required 
Date of next schedule update 
See, that isn’t so bad. Now, store that sheet of information in a safe place where it can be easily 
found. 
 
Releasing the Standard 
Now that you have all your notes collected to one sheet, it is time to deploy the CAD standard files. 
This can happen in one of two ways based on the material that you are releasing. 
 
If the material being released is a document, such as an actual best practice PDF, then it would be 
best to post that information to an intranet page. SharePoint or a password-protected site operated 
by your organization will serve well for this. If you do not have access to such a resource, then post 
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your PDF files to a server location available to everyone who needs access to the documents. 
Follow that placement with an email message to your team of CAD leaders and all CAD production 
staff. 
 
If the material being release is a library of detail drawings, then these must be saved to a server 
location that is accessible to everyone who will use them for production. This process should 
include you deleting the previous detail library directory and replacing it with a fresh instance copied 
from a safe, reliable seed source. This will ensure that any files that may have been altered, or 
“improved,” by well-meaning staff are reset to their approved release versions. 
 
Following the copying of the detail files to the server locations, an announcement should be posted. 
This can either be made on an intranet site, like SharePoint, or via email. The announcement 
should include a full list of details identifying any new or altered detail drawings. In the case of 
alterations to files, it should be noted what changes were made 
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Self-Check -1 

 
                Written Test 

 
1. CAD standard has a variety of aspects that require attention and different approaches 
(a) true 
 (b) false 
 
2. Standardized detail libraries, in addition to drawing templates and best practice documents, are 
key to the success of any nascent CAD standard  
 
(a) true 
 (b) false 
.  
 
 
Multiple Chose Test Answer 
 
 
Name:  _________________________             
Date:  _______________ 
 
Short Answer  
.1    
2.   

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 2 points            Unsatisfactory - below 2 points  
You can ask you teacher for the copy of the correct answers. 
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Drawing entity line  

Lines can be constrained to horizontal/ vertical by the ORTHO commands. CLOSE option 
uses the starting point of the first line segment in the current LINE command as the next 
point. 
 For more information watch on internet  
 https://www.youtube.com/watch?v=Swxy-ZOtunI 

1. Absolute Co-ordinate system Lines can be drawn using co-
ordinate system (rectangular Cartesian co-ordinates). To draw a rectangle (Fig. 21.4a): 
Command           :           LINE 

 From point: 10, 20 ↵ 

To point: 40, 20 ↵ 
To point: 40, 60 ↵ 
To point: 10, 60 ↵ 
To point:↵ 
 
 
 
 
 
 
 
 
 
Fig. 2.1 Absolute Co-ordinate system 

2. Relative co-ordinate system It is also possible to specify the 
co-ordinates in the incremental format as the distances from the current cursor position in 
the drawing area. The distance is specified by using the @ parameter before the actual 
value. To construct a triangle of given altitude (30) and base (40) (Fig. 21.4b): 
Command    :     LINE 

From Point: 10, 20 ↵ 

To point: @ 40, 0 ↵ 
To point: @ – 20, 30 ↵ 
To point: ↵ 
 
 
 

 
 
 
 

Information Sheet-2 Prepare standard Drawings  
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Fig. 2.2 Relative co-ordinate 

 
 
 

 
3. Polar Co-ordinate System It is also possible to specify the point co-ordinate using the ploar 

co-ordinate format. To construct a hexagon (Fig. 21.4c) of side 30: 
Command :  LINE 

From point: 10, 20 ↵  

To point: @ 30<0 ↵  
To point: @ 30<60 ↵  
To point: @ 30<120 ↵  
To point: @ 30<180 ↵  

To point: @ 30<240 ↵  
To point: close 

 
 
 
 
 
 
 
 
 
 
 
Fig. 2.3 Polar co-ordinate 

4. Direct distance entry  
In this method, the points are located to draw a line using the distance entry in the direction 
of the cursor. Consider the following example to generate the drawing given. 
Command :  LINE [ortho on] 
Specify the first point               :     20,20 move mouse horizontally right  
Specify next point or [undo]  :  60 move mouse vertically up 
Specify next point or [undo]  :  30 move mouse horizontally left 
Specify next point or [undo]  :  40 move mouse vertically up 
Specify next point or [undo]  :  20 move mouse horizontally left 
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Specify next point or [undo]  :  50 move mouse vertically down 
Specify next point or [undo]  :  press enter to complete the drawing 
 
 
Drawing entity ellipse  
This command allows one to draw ellipses or egg shaped objects. From Release 13 
onwards, ellipse is treated as a separate entity. The methods available for making ellipses 
are: 

1. By means of axis end points: (Fig. 21.5a) 

Command   :     ELLIPSE <axis end point 1>/ center: point ↵ 
           Axis end point 2   :   (point) <other axis distance>/ Rotation: 
 
 

 
Now, if the distance is entered, AutoCAD interprets it as half the length of the other axis. 

2. By means of centre, axis end points (Fig. 21.5b) 

       Command     :    ELLIPSE <axis end point 1>/ centre: C ↵ 
Centre point and one end point of each axis should be provided for the          response of 
the AutoCAD. 
Drawing entity polygon  
This option permits to make/draw polygons from 3 to 24 sides in a number of ways: 

1. For making inscribed/circumscribed polygon with a side 
parallel to x-axis: (Fig. 21.6a, b) 

a. Inscribed 
b. Circumscribed 

             Command     :    POLYGON 
Number of sides    :  8 

Edge/ <centre of polygon>    :    100, 200 ↵ 
Inscribed / circumscribed about a circle (I/C)   :   I or C ↵ 
           Radius of circle      :    80 

2. With edge option, specifying the size of the edge and 
orientation: (Fig. 21.7) 
Command     :      POLYGON 
Number of sides :   
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7 

Edge/<center of polygon> :  E ↵ 

First end point of edge :  15, 15 ↵ 
Second end point of edge :  15, 30 ↵ 
 
 
 
 
 
 
 
 
 

The above and various other entities that can be used for making an AutoCAD drawing may 
also be selected from the tool bar. 
Drawing entity rectangle 
A rectangle is a polygon based on two opposite corner points, known as diagonal points 
(Fig. 21. 8). 
Command    :    RECTANGLE 

First corner: 10, 15 ↵ 
Second corner: 60, 50 ↵ 
Or from the tool bar menu icon, the pointing device can drag the rectangle and the rectangle 
can be completed. 
 
 
 
 
 
 
 
 
Drawing circles  
Circle command offers several methods for drawing circles, the default being to choose a 
centre point and enter or pick a diameter or radius (Fig. 21. 9). 
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Command     :     CIRCLE 

1. 3P/ 2P/ TTR/ <center point>    :   Pick a center point or enter 
an option 

2.  Diameter/ <Radius><current default>   :   select D or R 
3. 3P (3 point) option: one is prompted for a first, second and 

third point.  The circle will be drawn to pass through these points. 
4. 2p (2 point) option: one is prompted for the selection of two 

points which form the opposite ends of the diameter. 
5. TTR option: allows one to define a circle based on two 

tangent points and a radius. The tangent points can be on lines, arcs or circles. 
Drawing entity Arc 
Arc command permits to draw an arc, using a variety of methods. 
Command    :    ARC 

1. Centre/ <start point>: pick a start point using mouse or select 
C for more options. 

2. Centre/End/ <second point>: pick a second point of the arc 
or select C, if option is C. 

3. Angle/length of chord/end point: pick end point of the arc, if 
option is E. 

4. Angle/Direction/Radius/ <center point>: pick end point of the 
arc or specify the option. Options (Fig. 21. 10.) 

 Angle — “included angle” prompt appears, to enter the 
value. 

 Centre — enter the location of an arc’s center point-at the 
prompt center-pick a point, 
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 Direction - enter a tangent direction from the starting point of 
an arc. At this prompt, pick a point with cursor. 

 End — at this prompt, pick the end point of the arc. 
 Length — enter the length of a arc’s chord. At this prompt, 

enter a length or drag and pick a length with cursor. 
 Radius — at the prompt “radius”, enter a radius value. 
 Start point — enter the beginning point of an arc. 

 
 
 
Object selection 
Editing capabilities are the most useful part of AutoCAD system, by making use of the 
already existing drawing. For the purpose of editing an object, it is necessary to make 
selection of the objects in the drawing. There are various options available for the selection 
of an object: 

1. Pick box—the cursor is converted to a small box/square, 
called pick box. By pressing the left button of the mouse when the pick box touches an 
entity, the object can be selected for editing. 

2. Window option—a single or group entities can be selected 
by bringing them fully inside a rectangular window. Entities, which lie only partially inside the 
boundaries of window, will not be selected. Rectangular window may be created by picking 
the first corner, by pressing the left button and then moving the mouse to the desired 
position of diagonally opposite corner. Selection of the object is complete, by pressing the 
button again. 
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HATCHING  
There are a large number of hatch patterns available when hatching drawings in AutoCAD 
2009. Some examples from the Other Predefined set of hatch patterns (Fig. 8.2 ) in the 
Hatch Pattern Palette Other hatch patterns can be selected from the ISO or ANSI hatch 
pattern palettes, or the operator can design his/her own hatch patterns and save them to the 
Custom hatch palette. 
First Example – hatching a sectional view ( Fig. 8.3 ) 
Figure 8.3 shows a two-view orthographic projection which includes a sectional end view. 
Note the following in the drawing: 

1. The section plane line, consisting of a centre line with its 
ends marked A and arrows showing the direction of viewing to obtain the sectional view. 

2. The sectional view labeled with the letters of the section 
plane line. 

3. The cut surfaces of the sectional view hatched with the 
ANSI31 hatch pattern, which is in general use for the hatching of engineering drawing 
sections. 
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Fig. 2.6 the Other Predefined Hatch Pattern Palette 
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Short Answer Questions 

1. When entering absolute coordinate numbers at the command line, the coordinates are preceded 
by:  

(a) The letter a 

 (b) The symbol @  

(c) The letters ab  

(d) There is no need to enter anything in front of the coordinate numbers  

2. The command line abbreviation for the Circle tool is:  

(a) cir 

(b) c 

(c) ci 

(d) cl.  

3. Associative hatching is a term given to: 

 (a) Types of hatching which can be joined together  

(b) Hatching which is associated with the colour of the area being hatched 

 (c) Hatching which is associated with objects which are moved within a hatched area 

 (d) Hatching which is associated with a hatched area from another part of a drawing. 

 4. The Hatch and Gradient dialog can be called to screen: 

 (a) By clicking the Hatch tool icon in the  Draw toolbar  

(b) By entering the abbreviation h at the command line  

(c) By entering hatch at the command line  

(d) By any one of the choices as given in a., b. or c. 

 

 

Multiple Chose Test Answer 

 
 
Name:  _________________________             Date:  _______________ 
 

Self-Check 2 Written Test 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 2 points            Unsatisfactory - below 2 points  
You can ask you teacher for the copy of the correct answers. 
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Short Answer  
.1    

2.      
     

Operation Sheet 1 Detail drawing 

 
Procedures  for ------------------ 
 

Procedure: 

 

           Step 1- Start auto CAD  

a. Start--- all program----auto desk---auto CAD. Or 

b. Double click on CAD icon on the desk top. Or  

c. Right click on CAD icon ---- open 

Step 2- Display the necessary tool bars  

d. Draw tool bar  

e. Modify tool bar  

f. Standard tool bar  

Step 3- Make adjustment  the necessary information 

g. units,  

h. drawing limits, 

i.  dimension style, 

j.  layers, etc... 

Step 4-  Prepare the given drawing or project. 

Step 5- Stored your drawing /save/ 

Step 6- Print the prepared drawing /out put/ 
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Fig. 2.7engineering drawing 
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Fig. 2.8 engineering drawing 
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Fig. 2.9 engineering drawing 
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Fig. 2.10 engineering drawing 
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Fig. 2.11 engineering drawing 
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2.2 StartingUpAutoCAD
®
2007 

.Selectthe AutoCAD2007 option on the Programmenuor select the  
AutoCAD2007 icon on the Desktop.Once the program is loaded into  
Memory,theAutoCAD®2007drawing screen will appear on the screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 3.1 Select the AutoCAD2007 option 
 

Information Sheet-3 reviewing CAD drawings 
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2.ChooseAutoCADClassicas the initial  
Workspace. 

 
 

3. SelectDon’t Show me this again and click OK 
to continue.  

 
Note that AutoCAD®automatically assigns generic name, DrawingX,asnew 
Drawingsarecreated. Inourexample,AutoCAD®openedthegraphicswindow 
using the default system units and assigned the drawing nameDrawing1.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 3.2AutoCAD® automatically assigns generic 
4.Close the Tool Palettes by clicking once on  

Close button located at the upper right 
cornerOfthewindowasshown.  

 
 
 
 
 

Material 
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DrawingUnitsSetup 

Every object we construct in a CAD system is measured in units. 
Weshoulddetermine 
Thevalue of the units within the CAD system before creating the first geometric 
entities. 

 
 

1.Inthe pull-down menus, select:  

 
[Format][Units] 

 

 Fig. 3.3Drawing Units Setup 

 
 
 
 
TheDrawingUnitsdialog box, set theLength TypetoDecimal. This will set 
the measurement to the default English units, inches.  l 
 
 
Set the Precision totwo digits after the decimal point as shown in the 

above 
figure.  

 

5.Close the Sheet Set Managerbyclickin gone 

On the Closebutton located at the upper right 

cornerofthewindowasshown.  

2. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. 
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4.PickOK to exitthe DrawingUnitdialogbox 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Fig. 3.4 Drawing Unit dialog box 
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                                        Fig. 3.4 Drawing Unit dialog box 

 

DrawingAreaSetup 
Next, we will set up theDrawingLimits; setting theDrawingLimits controls the  
extents of the display of the grid.It also serves as a visual reference that marks 
the  
workingarea. Itcan also be used to prevent construction outside the grid limits 
and as a  
plot option that defines an area to be plotted/printed. Note that this setting does 
notlimit 
theregion for geometry construction.  

 
1.Inthe pull-down menus,select:  

 
[Format][Drawing Limits] 

2.Inthecommandpromptarea,nearthe
bottomoftheAutoCAD® drawing  

screen,the message“Reset Model Space Limits:Specify lower left 
corner or  

[On/Off] <0.00,0.00>:” is displayed. Press the ENTERkey once to 
accept the 

Defaultcoordinates <0.00,0.00>.  

 
 
 
 
 



  

    
 
 

 
Page 83 of 167 
 

Federal TVET 
Agency 
Author/Copyright  

TVET program titleROAD CIVIL 
WORKS    

Version -1 
October 2019 

 
 
 

3.In the command prompt area, the message “Specify upper right corner  
<0.00,0.00>:” is displayed. Press the ENTERkeyonce to accept the 

default 
coordinates<12.00,9.00>.  

 
 
Fig. 3.4 Drawing Unit dialog box 
4.On your own, move the graphic cursor near theupper-rightcomerinside 

the drawing area and note that the drawing area is unchanged. (TheDrawing 
Limits command is used to set the drawing area; but the display will not be  

adjusteduntil display commandis used.) 1-6 

 

 

 

 

 

 
 

 

 

 

5.Inthe pull-down menus, select:  

 
[View][Zoom][All] 

 
Fig. 3.4 Drawing Unit dialog box 

TheZoom All command will  
adjust 

the display so that all objects in  
thedrawing are displayed to be  
as 
large as possible. If no  
objects 
are 
constructed, theDrawing 
Limits 
are used to  
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adjustthecurrent viewport.  
 
6.Move the graphic cursor near  
the 
upper-right comer  
insidethedrawingarea and  
note that the display area is  

updated.  

 

UsingtheLineCommand 

1.ClickontheInfoPaletteoptionin the Help 
pull-down menu to activate 

theQuickHelp 
option. 

 

 

 

 
 
 
 
 
 

2.Move the graphics cursor to the first icon in  
 
theDrawtoolbar. 

This icon istheLineicon. Ahles-tip box appears next to  
the cursor and a brief description of the icon is  
displayed at the bottomoftheAutoCAD®drawing 
screen: “CreatesStraight 
linesegments: LINE.”  
 

3.Select the icon by clicking once with the left-
mouse-button,  

which will activate the Line command.  

 
 

Notice brief explanation of the selected  
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command is displayed in the Info Palette  
window. Itishigh lyrecommendedthatyou read 
theexplanations to gain some insights on the  
generalprocedureofusingAutoCAD®.  

 
4.In the Info Palettewindow, click To draw 

LinestoopentheAutoCAD® Help windowand 
geta more detailed explanation on the procedure. 
 

 
 

The general procedure to create a line 
inAutoCAD® is displayed in the Info 
Palette window. 

 
5.Click on Close button located at the  
upper left corner of the Info Palette 
windowasshown.  

 
 
 
 
 
 
 
 

6.Inthecommandpromptarea,nearthebottomoftheAutoCAD®drawing screen, 
the message “_line Specify first point:” is displayed. AutoCAD® expects us 

to 
identify the starting location of a straight line. Move the graphics cursor 

inside  
the graphics window and watch the display of the coordinates of the 

graphics 
cursor the bottomoftheAutoCAD®drawing screen. The threenumbers  
represent the location of the cursor in the X, Y, and Z directions. Wecan 

treat 
the graphics window as if it was a piece of paper and we are using the 

graphics  
cursors if it were a pencil with which to draw.  
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Mae 

We will create a freehand sketch of a five- 
point star using theLinecommand. Donot 

 

5  

 
32 

 
 
 
 
 
 
 
 

14 

Coordinates of the location 

ofthegraphicscursor. 

be overly concerned with the actual size or  

theaccuracy of your freehand sketch.This 

exercise is to give you a feel for the  

AutoCAD
®
 2007 user interface. 
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7.We will start at a location near 
the bottom of the graphics 

window.  
Left-clickonce to position the  
starting point of our first line.  
This will be point 1 of our sketch.  

 
The two numbers, displayed 
next to 
the cursor, represent the current  
cursor position. Note that the  
same 
two numbers are also displayed at  
the 
lower left corner of theAutoCAD  
main window. Thedisplayingof 
tooltips is known as theDynamic 
Input option. Tooltinsure 
displayed 
Nearthe cursor, which are 
Dynamicallyupdatedas the  
cursor 
moves.  

 
 

8.Next move the cursor upward  
and toward the right side of  
point 1.Notice the rubber-

band  
line that follows the graphics  
cursor inthegraphicswindow.  
Left-click again (point 2) and 

we 
Havecreated the  
First lineof our sketch. 

 
 

•The two numbers, displayed  

1-8AutoCAD
®
 2007 Tutorial 
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next 
to the cursor, represent the 
distanceand 
angleofthecurrent 
cursor position relative to the  
previously selected location  
on 
the screen. This feature is  
also 
part of the Dynamic Input 
option. Amor detailed 
discussion on how to utilize  
this 
feature is presented in  
of this text.

9.Move the cursor to theleftof 

point2 and create a horizontal line 

roughly about the same length as  

the first line on the screen.  



  

    
 
 

 
Page 89 of 167 
 

Federal TVET 
Agency 
Author/Copyright  

TVET program titleROAD CIVIL 
WORKS    

Version -1 
October 2019 

 
 
 

AutoCAD
®
Fundamentals1-9 

 

 

 

 

 

11.Notice that the Linecommandremainsactivated even after  

Weconnectedthe last segment of the line to the  
starting 
point(point1)ofoursketch. Inside the graphicswindow, 
clickoncewiththeright-mouse-button and  
popupmenu 
appears on the screen. 

 
12.SelectEnter with the left-mouse-button to endthe Line 

command. (Thisisequivalent to hitting the [ENTER] key 
on the keyboard.)  

 

 

 

10.Repeat the above steps and complete  

the freehand sketch by adding three more 

lines(from point 3topoint 4, point 4 to  

point5, and then connecttopoint 5back  

topoint1). 

5  

 
32  

 
 
 
 
 
 
 
 

14  

13.On your own, move the cursor near point 2and point 3, and estimate thelengthof  

the horizontal line by watching the displayed coordinates for each point at the  

bottomofthescreen.  
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VisualReference 

The method we just used to create the freehand sketch is known as 
theinteractive  
method, where we use the cursor to specify locations on the screen. 
Thismethods 
perhapsthe fastest way to specify locations on the screen. However, it is 
rather difficult 
to try to create a line of a specific length by watching the displayed 
coordinates. It would 
be helpful to know what one inch or one meter looks like on the screen 
while we are  
creating entities.AutoCAD®2007provides us with many tools to aid the 
construction  
of our designs. We will use theGRIDandSNAP options to get a visual 
reference as to  
the size of objects and learn to restrict the movement of the cursor to a set 
increment on  
the screen.  

TheStatusBarareais located at the bottom of theAutoCADdrawing 
screen.The words 
SNAP, GRID, ORTHO, POLAR, OSNAP, OTRACK,DUCS,LWTandMODEL 
appearing  
Tothe right of the coordinates are buttons that we can left-click to turn 
these special  
OptionsONandOFF.When the corresponding button is highlighted, the 
specific option  
is turned ON. These buttons act as toggle switches; each click of the 
button will toggle 
theoptionON or OFF. Usingthebuttons is a quick and easy way to make 
changes to  
thesedrawing aidoptions. We can toggle the options on and off in the 
middle of another  
command.  

 
 
 
 
 

OptionButtons 
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2.Movethecursor inside the graphics window, and estimate the distance 

in between 
the grid points by watching the coordinates display at the bottom of 

the screen. 
 
 

 

 
 
TheGRIDoption creates a pattern of  
dots 
that extends over an area on the  
screen.  
Using the grid is similar to placing a  
sheet 
of grid paper under a drawing. The grid  
helps you align objects and visualize  
the 
distance between them. The grid is not  
displayed in the plotted drawing. The 
default grid spacing, which means the 
distance in between two dots on the  
screen, 
is 0.5 inches.  
Wecanseethatthesketched 

GRID On 

1.Left-click the GRID button in the Status Bar to turn On the GRID option.(Notice 

in the command prompt area, the message “<Gridon>” is also displayed.)  

a 
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horizontal line in the sketch is about4.0 
inches long. 

 

 

DYNOff  

1.Left-click theDYNbutton in the StatusBar to turn Off theDynamic 
Inputoption.  

 
 
 
 
 

TheDYNbutton allows the quick toggle of the Dynamic Inputoption.  
We will switch off this option to discuss the basic input options 

available in  
AutoCAD®.Amore detailed discussion on this feature is presented in 

Chapter 
three.  

 

SNAPOn  

1.Left-click theSNAPbuttonin the Status Bar to turn OntheSNAP option
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TheSNAPoption controls an invisible rectangular grid that restricts cursor 
movement to specified intervals. WhenSNAPmode is on, the screen cursorand  
allinputcoordinates are snapped to the nearest point on the grid. Thedefault 
snap 
intervalis 0.5 inches, and aligned to the grid points on the screen. 

 
 

3.ClickontheLineiconintheDrawtoolbar.Inthe 
command 
 

Prompt area, the message “_line Specify first  
Point:” is  
Displayed. 

 
 
 
 
 
 

4.On your own, create another sketch of the five-point star with 
theGRIDand SNAP options switched ON.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

C 

d 
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AutoCAD
®
Fundamentals1-13 

 
 

 
 

 
1.PickErase in the Modifytoolbar. ( 
Theiconis 

the first icon in the Modify toolbar.  
Theironis 
A picture of an eraser at the end of a  
pencil.)  
Themmessage“Select objects”is  
displayed 
inthecommandprompt areaand 
AutoCAD®aweitsus toweled the 
objects to erase.  

 

 
 
 
 
 
 
 
 
 
 
 
 

5.Usetheright-mouse-button and select Enter in the popup 

menu to end the Linecommandifyouhavenotdoneso.  
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2.Left-click theSNAPbutton on the StatusBartoturnoff the SNAP option so  

that we can more easily move the cursor on top of objects. We  
can toggle the 
Status Bar optionsONorOFFinthemiddlefanothercommand. 

 
 
 
 
 

3.Right-mouse-clickonce to accept the selections. The selected two  

lines are 

erased.  
 
 

 

RepeattheLastCommand 

1.Insidethe graphics window, click once with  
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the right- 
mouse-button to bring up the popup  

option menu.  

 
2.PickRepeatErase,with the left-mouse- 
button, in the  
popup menu to repeat the last command.  
Notice the other 
options available in the popup menu. 

 
AutoCAD®2007offers many options to  
accomplish the  
same task. Throughout this text, we  

willemphasize the use of theAutoCADHeads-upDesignsinterface, which means 
we focus on the screen, not on the  
keyboard.  

 
3.Movethecursor to a location that is above and toward the left side of the  
Entitiesonthe screen.Left-mouse-click once to start a corner of a rubber-band 

window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.Move the cursor toward the right andbelow the entities, and then left-

Firstcorner 

Secondcorner 
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mouse- 
Clickto enclose all the entities inside theselection window. 

Noticeallentities 
Thatare inside the window are selected.  

 
5.Inside the graphics window, right-mouse-click once to proceed with 

erasing  

What is Supervision? 
Supervision is a widely misunderstood term. Many people believe it applies only to people who 
oversee the productivity and development of entry-level workers. That’s not true. 
 
The term “supervisor” typically refers to one’s immediate superior in the workplace, that is, the 
person whom you report directly to in the organization. For example, a middle manager’s 
supervisor typically would be a top manager. A first-line manager’s supervisor would be a middle 
manager. A worker’s supervisor typically would be a first-line manager. 
 
Supervisors typically are responsible for their direct reports’ progress and productivity in the 
organization. Supervision often includes conducting basic management skills (decision making, 
problem solving, planning, delegation and meeting management), organizing teams, noticing the 
need for and designing new job roles in the group, hiring new employees, training new 
employees, employee performance management (setting goals, observing and giving feedback, 
addressing performance issues, firing employees, etc.) and ensuring conformance to personnel 
policies and other internal regulations. Supervisors typically have strong working knowledge of 
the activities in their group, e.g., how to develop their product, carry out their service, etc. 
Computer Aided Design (CAD) Supervising 
Supervise CAD Designers, creating schedules, assigning tasks and resources, and ensuring 
team members receive training. 
Identify issues and recommend solutions and improvements for CAD procedures. 
Assist CAD management with customer and/or vendor design reviews, meetings, and/or 
consultations. 
Provide technical support to CAD Designers and Engineers, Sales teams, and Production teams. 
Perform duties as a CAD Designer, translating specifications into designs, models, and products 
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Short Answer Questions 
 

• 1. Every object we construct in a CAD system is measured in units 
A. TRUE 
B. FOLSE 
 

2. SupervisionWho oversee the productivity and development of entry-level workers 
 

A. TRUE 
B. FOLSE 

 
 
 
 
 
 
Answer Sheet 
 
 
 
Name:  _________________________             Date:  _______________ 
 
Multiple Chose Test Answer  
1.     
2.     
 
 
 
 
 
 
 
 
 
 
 
 

Self-Check 3 Written Test 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 2 points            Unsatisfactory - below 2 points  
You can ask you teacher for the copy of the correct answers. 
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LAP Test  

 
 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________  Time finished: ________________ 

 

Instructions: Given necessary templates, workshop, tools and materials you are required to 

perform the following tasks within 3  hours. 

 

Task 1: Clean the given tools and equipment. 

 

Task 2: list the different modify/editing/ tools and their functions. 

Task 3:  Using the given template, prepare a computer lab schedule for the specific area in the 

workshop. In preparing the CAD schedule -   

 identify the: 

 Required soft ware  

 Type of drawing and steep drawing  

 Computer lab. 

 consider the: 

 procedures and standards 

 frequency of maintenance activities 

 

Task 4:  Perform the auto-CAD software in the assigned computer lab.  

Plate Number 5 
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Plate Number 1 
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Plate Number 2 

 
 
 
Plate Number 3 
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Plate Number 4 

 
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Plate Number 5 
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Instruction Sheet Learning Guide #14 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics: 

 Creating and guiding  BasicCAD drawings 

 CAD drawings oprating procedures  

 Supervising CAD drawing  

 preparing simple drawings  

 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to: 

 Basic CAD drawings are created and guidance is sought as required. 

 Drawings are prepared in accordance with standard operating procedures. 

 As required, CAD drawings are reviewed with supervisor and/or other designated staff in 

accordance with company procedures 

 Detailed drawing is produced in third angle projection, including auxiliary views, sections 

and assemblies 

Learning Instructions:  

1,  Read the specific objectives of this Learning Guide.  

Follow the instructions described below 41.  

3, Read the information written in the information “Sheet 1, Sheet 2, Sheet 3 Sheet 4 Sheet 5 

Sheet 6 and Sheet 7”. 

4, Accomplish the “Self-check 1,Self-check t 2, Self-check 3 Self-check 4 Self-check 5 Self-

check 6   and Self-check 7” in page 138, 139, and 140respectively.  

5, If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation Sheet 1, 

in page -141, 

6, Do the “LAP test” in page – 144 (if you are ready).  
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Introduction  

The Modify tools are among those most frequently used. The tools are found in the 

Home/Modify panel. A click on the arrow in the Home/Modify panel brings down a further set of 

tool icons (Fig. 5.1). They can also be selected from the Modify toolbar (Fig. 5.2) or from the 

Modify drop-down menu. Using the Erase tool from Home/Modify was described in Chapter 2. 

Examples of tools other than the Explode follow. See also Chapter 10 for Explode. 

 

 

Fig. 3.1 The Modify tool icons in the Home / Modify panel 

 

 

Fig. 3.2 the Modify toolbar 

 

The copy tool  

Information Sheet-1 locatting and modifing Existing 
CAD drawings 
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First example – Copy (Fig. 5.5) 

1. Construct Fig. 5.3 using Polyline. Do not include the dimensions. 

2. Call the Copy tool – left-click on its tool icon in the Home/Modify panel (Fig. 5.4 ), pick 

Copy from the Modify toolbar, or enter cpor copyat the command line. 

 

 

Fig. 3.3 First example – Copy Object – outlines 

The command line shows: 

Command: _copy 

Select objects: pick the cross 1 found 

Select objects: right-click 

Current settings: Copy mode _ Multiple 

Specify base point or [Displacement/mode/Multiple] _ Displacement _ : pick 

Specify second point or _ use first point as displacement _ : pick 

The result is given in Fig. 5.5 . 
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Fig. 3.4 The Copy tool from the Home / Modify panel 

 

Fig. 3.5 First example – Copy 

Second example – Copy – Multiple copy ( Fig. 5.6 ) 

1. Erase the copied object. 

2. Call the Copy tool. The command line shows: 

Command: _copy 

Select objects: pick the cross 1 found 

Select objects: right-click 

Current settings: Copy mode _ Multiple 

Specify base point or [Displacement/mode] _ Displacement _ : pick 

Specify second point or _ use first point as displacement _ : pick 

Specify second point or [Exit/Undo] _ Exit _ : pick 
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Specify second point or [Exit/Undo] _ Exit _ : pick 

Specify second point or [Exit/Undo] _ Exit _ : e (Exit) Command : 

The result is shown in Fig. 5.6 . 

 

Fig. 3.6 Second example – Copy – Mutiple – Multiple copy 

The mirror tool 

First example – Mirror ( Fig. 5.9 ) 

1. Construct the outline shown in Fig. 5.8 using the Line and Arc tools. 

2. Call the Mirror tool – left-click on its tool icon in the Home/Modify panel ( Fig. 5.7), p ick the 

Mirror tool icon from the Modify toolbar, 

pickMirror from the Modify drop-down menu, or enter mi or mirror at the command line. The 

command line shows: 

 

Command: _mirror 

Select objects: pick first corner Specify opposite corner: pick 7 found 

Select objects: right-click 

Specify first point of mirror line: end of pick 

Specify second point of mirror line: end of pick 

Erase source objects [Yes/No] _ N _ : right-click 

Command: 

The result is shown in Fig. 5.9. 
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Fig. 3.7 The Mirror tool from the Modify toolbar 

 

 

Second example – Mirror ( Fig. 5.10 ) 

1. Construct the outline shown in the dimensioned polyline in the upper drawing of Fig. 5.10 . 
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2. Call Mirror and using the tool three times complete the given outline. 

The two points shown in Fig. 5.10 are to mirror the right-hand side of the outline. 

 

The offset tool 

Examples – Off set ( Fig. 5.14 ) 

1. Construct the four outlines shown in Fig. 5.13 . 

2. Call the Offset tool – left-click its tool icon in the Home/Modify panel 

(Fig. 5.12 ), pick the tool from the Modify toolbar, pick the tool name in the Modify drop-down 

menu, or enter o or offset at the command line. 

The command line shows: 
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Fig. 3.12 The Offset tool from the Home / Modify panel 

Command: _offset 

Current settings: Erase source _ No Layer _ 

Source OFFSETGAPTYPE _ 0 

Specify offset distance or [Through/Erase/Layer] _ Through _ : 10 

Select object to offset or [Exit/Undo] _ Exit _ : pick drawing 1 

Specify point on side to offset or [Exit/Multiple/ 

Undo] _ Exit _ : pick inside the rectangle 

Select object to offset or [Exit/Undo] _ Exit _ : e (Exit) 

Command: 

3. Repeat for drawings 2 ,3 and 4 in Fig. 5.13 as shown in Fig. 5.14 . 
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The Array tool 

Arrays can be either in a Rectangular form or in a Polar form as shown in 

the examples below. 

 

First example – Rectangular Array ( Fig. 5.17 ) 

1. Construct the drawing as shown in Fig. 5.15 . 

2. Call the Array tool – either click Array in the Modify drop-down menu ( Fig. 5.16 ), from the 

Home/Modify panel, pick the Array tool icon from the Modify toolbar, or enter aror array at the 

command line. The Array dialog appears ( Fig. 5.17 ). 
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3. Make settings in the dialog: 

● Rectangular Array radio button set on (dot in button) 

● Row field – enter 5 

 

Fig. 3.16 S electing Array from the M odify drop-down menu 

● Column fi eld – enter 6 

● Row offset fi eld – enter _ 50 (note the minus sign) 

● Column offset fi eld – enter 50 . 

4. Click the Select objects button and the dialog disappears. Window the drawing. A second 

dialog appears which includes a Preview _ button. 

5. Click the Preview _ button. The dialog disappears and the following prompt appears at the 

command line: 

Pick or press Esc to return to drawing or _ Right-click to accept drawing _ : 

6. If satisfiedright-click. If not, press the Esc key and make revisions to the Array dialog fi elds as 

necessary. 

The resulting array is shown in Fig. 5.18 . 
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Fig. 3.17 First example – the Array dialog 
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Second example – Polar Array ( Fig. 3.18 ) 

 

1. Construct the drawing shown in Fig. 5.19 . 

2. Call Array. The Array dialog appears. Make settings as shown in 

Fig. 5.20 . 

 

Fig. 3.19Second example – Array – settings in the dialog 

3. Click the Select objects button of the dialog and window the drawing. 
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The dialog returns to screen. Click the Pick center point button ( Fig. 5.21 ) and when the dialog 

disappears, pick a center point for the array. 

4. The dialog reappears. Click its Preview _ button. The array appears and the command line 

shows: 

Pick or press Esc to return to drawing or _ Right-click to accept drawing _ : 

5. If satisfied right-click If not, press the Esc key and make revisions to the Array dialog fields as 

necessary. 

The resulting array is shown in Fig. 5.22 . 

 

Fig. 3.20Second example – Array – the P ick Center point button 
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The move tool 

Example – Move ( Fig. 5.25 ) 

1. Construct the drawing shown in Fig. 5.23 . 

2. Call Move – click the Move tool icon in the Home/Modify toolbar ( Fig. 5.24 ), pick Move from 

the Modify panel, pick Move from the 

Modify drop-down menu, or enter m or move at the command line, which shows: 

Command: _move 

Select objects: pick .the middle shape in the drawing 1 found 

Select objects: right-click 

Specify base point or [Displacement] _ Displacement _ : pick 

Specify second point or _ use first point as displacement _ : pick 

Command: 

The result is given in Fig. 5.25 . 
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The Rotate tool 

When using the Rotatetool remember the default rotation of objects within AutoCAD 2009 is 

counterclockwise (anticlockwise). 

Example – Rotate ( Fig. 5.27 ) 

1. Construct drawing 1 of Fig. 5.27 with Polyline . Copy the drawing 1 three times (Fig. 5.27 ). 

2. Call Rotate – left-click its tool icon in the Home/Modify panel ( Fig. 5.26 ), pick its tool icon 

from the Modify toolbar, pick Rotatefrom the Modify drop-down menu, or enter roor rotate at 

the command line. The command line shows: 

Command: _rotate 
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Current positive angle in UCS: ANGDIR _ counterclockwise ANGBASE _ 0 

Select objects: window the drawing 3 found 

Select objects: right-click 

Specify base point: pick 

 

 

Fig.3.22The Rotate tool icon from the Home/Modify panel 

Specify rotation angle or [Copy/Reference] _0 _ : 45 

Command: and the first copy rotates through the specified angle. 

3. Repeat for drawings 3 and 4 rotating as shown in Fig. 5.27 . 
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The scale tool 

Examples – Scale ( Fig. 5.29 ) 

1. Using the Rectangle and Polyline tools, construct drawing 1 of Fig. 5.29 . The Rectangle fi 

lets are R10. The line width of all parts is 1 . Copy the drawing 3 times to give drawings 2 ,3 and 

4 . 

2. Call Scale – left-click its tool icon in the Home/Draw panel ( Fig. 5.28 ), pick its tool icon in the 

Modify toolbar, pick Scale from the Modify drop-down-menu or, click its tool in the Modify 

toolbar or, enter scor scale at the command line which then shows: 

 

Fig. 3.25The Scale tool icon from the Home / Modify toolbar 

Command: _scale 

Select objects: window drawing 2 5 found 

Select objects: right-click 
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Specify base point: pick 

Specify scale factor or [Copy/Reference] _1 _ : 0.75 

Command: 

3. Repeat for the other two drawings 3 and 4 scaling to the scales given with the drawings. 

The results are shown in Fig. 5.29 . 

 

The trim tool 

This tool is one which will be in frequent use when constructing drawings. 

First example – Trim ( Fig. 5.31 ) 

1. Construct the drawing Original drawing shown in Fig. 5.31 . 

2. Call Trim – left-click its tool icon in the Home/Modify panel, pick its tool icon in the Modify 

toolbar Fig. 5.30 ), pick Trim from the Modify drop-down menu, or enter tror trim at the 

command line, which then shows: 

Command: _trim 

Current settings: Projection UCS. Edge _ None 

Select cutting edges: pick the left-hand circle 1 found 

Select objects: right-click 

Select objects to trim or shift-select to extend or [Fence/Project/Crossing/Edge/erase//Undo]: pick 

one of the objects 

Select objects to trim or shift-select to extend or 

[Fence/Crossing/Project/Edge/erase/Undo]: pick the second of the objects 
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Select objects to trim or shift-select to extend or [Project/Edge/Undo]: right-click 

Command: 

 

Fig. 3.26The T rim tool icon from the Modify toolbar in the AutoCAD Classic workspace 

3. This completes the First stage as shown in Fig. 5.31. Repeat the Trim sequence for the 

Second stage. 

4. The Third stage drawing of Fig. 5.31 shows the result of the trims at the left-hand end of the 

drawing. 

5. Repeat for the right-hand end. The fi nil result is shown in the drawing labelled Result in Fig. 

5.31 . 

 

Second example – Trim ( Fig. 5.32 ) 
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1. Construct the left-hand drawing of Fig. 5.32 . 

2. Call Trim. The command line shows: 

Command: _trim 

Current settings: Projection UCS. Edge _ None 

Select cutting edges … 

Select objects or _ select all _ : pick the left-hand arc 1 found 

Select objects: right-click 

Select objects to trim or shift-select to extend or 

[Fence/Crossing/Project/Edge/erase/Undo]: e (Edge) 

Enter an implied edge extension mode [Extend/No extend] _ No extend _ : e (Extend) 

Select objects to trim: pick 

Select objects to trim: pick 

Select objects to trim: right-click 

Command: 

3. Repeat for the other required trims. The result is given in Fig. 5.32 . 

 

The stretch tool 

Examples – Stretch ( Fig. 5.34 ) 

As its name implies, the Stretch tool is for stretching drawings or parts of drawings. The action of 

the tool prevents it from altering the shape of circles in any way. Only crossing or polygonal 

windows can be used to determine the part of a drawing which is to be stretched. 



 

    
 
 

 
Page 126 of 167 
 

Federal TVET 
Agency 
Author/Copyright  

TVET program titleROAD CIVIL 
WORKS    

Version -1 
October 2019 

 
 
 

1. Construct the drawing labelled Original in Fig. 5.34 , but do not include the dimensions. Use 

the Circle ,Arc , Trim and Polyline Edit tools. 

The resulting outlines are plines of width _ 1. With the Copy tool make two copies of the drawing. 

 

Fig. 5.33 The Stretch tool icon from the Home / Modify panel 

 

Note 

In each of the three examples in Fig. 5.34 , the broken lines represent the crossing windows 

required when Stretch is used. 

2. Call the Stretch tool – click on its tool icon in the Home/Modify panel ( Fig. 5.33 ), left-click on 

its tool icon in the Modify toolbar, pickets name in the Modify drop-down menu or enter s or 

stretch at the command line, which shows: 

Command: _stretch 
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Select objects to stretch by crossing-window or crossing-polygon... 

Select objects: enter c right-click 

Specify first corner: pick Specify opposite corner: pick 1 found 

Select objects: right-click 

Specify base point or [Displacement] , _Displacement_ : pick beginning of arrow 

Specify second point of displacement or _ use first point as displacement _ : drag in the direction 

of the arrow to the required second point and right-click 

 

 

 

Note 

1. When circles are windowed with the crossing window no stretching can take place. This is 

why, in the case of the fi rest example in 

Fig. 5.33 , when the second point of displacement was picked , there was no result – the 

outline did not stretch. 

2. Care must be taken when using this tool as unwanted stretching can occur. 

The break tool 

Examples – Break ( Fig. 5.36 ) 

1. Construct the rectangle, arc and circle ( Fig. 5.36 ). 

2. Call Break – click its tool icon in the Home/Modify panel ( Fig. 5.35 ), pick its tool icon in the 

Modify toolbar, click Break in the Modify drop-down menu, or enter bror break at the command 

line, which shows: 
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Fig. 3.30The Break tool icon from the Home / Modify panel 

For drawings 1 and 2 

Command: _break Select object: pick at the point 

Specify second break point or [First point]: pick 

Command: 

For drawing 3 

Command: _break Select object pick at the point 

Specify second break point or [First point]: enter f right-click 

Specify first break point: pick 

Specify second break point: pick 

Command: 

The results are shown in Fig. 5.36 . 
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Note 

Remember the default rotation of AutoCAD 2009 is counterclockwise. 

This applies to the use of the Break tool. 

The join tool 

The Join tool can be used to join planes provided their ends are touching; 

to join lines which are in line with each other; to join arcs and convert arcs 

to circles. 

Examples – Join (Fig. 5.38 ) 

1. Construct a rectangle from four separate planes – drawing 1 of Fig. 5.38 ; construct two lines – 
drawing 2 of Fig. 5.38 and an arc – drawing 3 of Fig. 5.38 . 
2. Call the Join tool – click the Join tool icon in the Home/Modify panel( Fig. 5.37 ), left-click its 

tool icon in the Modify toolbar, select Join from the Modify drop-down menu or enter join or j at 

the command line. The command line shows: 
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Fig. 3.32The Join tool icon from the Home / Modify panel 

Command: _join Select source object: 

Select objects to join to source: pick a plane 

1 found 

Select objects to join to source: pick another 

1 found, 2 total 

Select objects to join to source: pick another 

1 found, 3 total 

Select objects to join to source: right-click 

3 segments added to polyline 

Command: right-click 

JOIN Select source object: pick one of the lines 

Select lines to join to source: pick the other 

1 found 

Select lines to join to source: right-click 

1 line joined to source 

Command: right-click 
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JOIN Select source object: pick the arc 

Select arcs to join to source or [close]: enter l right-click 

Arc converted to a circle. 

Command: 

The results are shown in Fig. 5.38 . 

 

The extend tool 

Examples – Extend ( Fig. 5.40 ) 

1. Construct planes and a circle as shown in the left-hand drawings of Fig. 5.40 . 

2. Call Extend – click the Extend tool in the Home/Draw panel, click its tool icon in the Modify 

toolbar ( Fig. 5.39 ), pick Extend from theModifydrop-down menu, or enter ex or extend at the 

command linewhich then shows: 
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Fig. 3.35The Extend tool icon from the Modify toolbar in the AutoCAD Classic workspace 

 

Command: _extend 

Current settings: Projection _ UCS Edge _ Extend 

Select boundary edges … 

Select objects or _ select all _ : pick 1 found 

Select objects: right-click 

Select object to extend or shift-select to trim or[Fence/Crossing/Project/Edge/Undo]: pick  
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Repeat for each object to be extended. Then: 

Select object to extend or shift-select to trim or [Fence/Crossing/Project/Edge/Undo]: right-click 

Command: 

 

Note 

Observe the similarity of the Extend and No extend prompts with those of the Trim tool. 

The fillet and chamfer tools 

These two tools can be called from the Home/Modify panel. There are similarities in the prompt 

sequences for these two tools. The major differences are that only one (Radius ) setting is 

required for a fi llet, but two (Dist1 and Dist2 ) are required for a chamfer. The basic prompts for 

both are: 

Fillet 

Command: _fillet 

Current settings: Mode _ TRIM, Radius _ 1 

Select first object or [Polyline/Radius/Trim/multiple]: enter r (Radius) right-click 

Specify fillet radius _ 1 _ : 15 

Chamfer 

Command: _chamfer 

(TRIM mode) Current chamfer Dist1 _ 1, Dist2 _ 1 

Select first line or [Undo/Polyline/Distance/Angle/ 

Trim/method/Multiple]: enter d (Distance) right-click 

Specify first chamfer distance _ 1 _ : 10 

Specify second chamfer distance _ 10 _ : right-click 

Examples – Fillet ( Fig. 5.42 ) 

1. Construct three rectangles 100 by 60 using either the Line or the 

Polyline tool ( Fig. 5.42 ). 

2. Call Fillet – click the arrow to the right of the tool icon in the Home/ 
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Modify panel and select Fillet from the menu which appears 

( Fig. 5.41 ), pick its tool icon in the Modify toolbar, pick Fillet from the 

Modify drop-down menu, or enter f or fi lletat the command line which then shows: 

 

Fig. 3.39Select Fillet from the menu in the Home / Modify panel 

 

Examples – Chamfer ( Fig. 5.44 ) 

1. Construct three rectangles 100 by 60 using either the Line or the Polyline tool. 

2. Call Chamfer – click the arrow to the right of the tool icon in the Home/Modify panel and 

select Chamfer from the menu which appears ( Fig. 5.43 ), c lick on its tool icon in the Modify 

toolbar, pick 

Chamfer from the Modify drop-down menu, or enter cha or chamferat the command line which 

then shows: 
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Fig. 3.43 S elect Chamfer from the Modify panel 

Command: _chamfer 

(TRIM mode) Current chamfer Dist1 _ 1, Dist2 _ 1 

Select first line or [Undo/Polyline/Distance/ 

Angle/Trim/ 

Me thod/Multiple]: d 

Specify first chamfer distance _ 1 _ : 10 

Specify second chamfer distance _ 10 _ : right-click 

Select first line or [Undo/Polyline/Distance/Angle/ 

Trim/ Me thod/Multiple]: pick the first line for the chamfer 

Select second line or shift-select to apply corner: pick 

Command: 

The other two rectangles are chamfered in a similar manner except that the No trim prompt is 

brought into operation with the bottom left-hand 

example. 
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Edit command  

The commands used for modifying the drawings fall under this category. Using these 

commands,the objects may be erased, retrieved, moved to another location, made into multiple 

copies, rotated, enlarged, mirror imaged, part of a drawing may be moved and the above effects 

can also be reversed (undo). 

ERASE Command—this lets the entities to be permanently removed from the drawing. 

The command format is 

Command: ERASE 

Select objects: (desired objects) once it is entered, the objects/portion of the object is erased/ 

deleted. 

OFFSET Command—this constructs an entity parallel to another entity at either a specified 

distance or through a specified point. 

MIRROR Command—this allows to mirror the selected entities in the drawing. The original 

objects can be deleted (like a move)/retained (like a copy). 

MOVE Command—the move command is used to move one/more existing drawing entities from 

one location in the drawing to another. 

COPY Command—this is used to duplicate one or more existing drawing elements at another 

location without erasing the original. 
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BASIC DIMENSIONING 

 

In many applications, a drawing should contain annotations showing lengths or distances or 

angles between objects to convey the desired information. Dimensioning is the process of adding 

these annotations to a drawing. AutoCAD provides four basic types of dimensioning; linear, 

angular, diameter and radius. 

DIM and DIMI Commands—DIMI command allows executing one dimensioning command and 

then returns to the normal command mode. If several dimensioning commands are to be 

executed, DIM command should be used. In this mode, the normal set of AutoCAD commands is 

replaced by a special set of dimensioning commands. To end the process of dimensioning, 

EXIT command has to be used. 

The dimensioning commands can be grouped into six categories: 

1. Linear — is done with a horizontal, vertical, aligned and rotated command. However, 

rotated command requires specifying the dimension line angle explicitly. 
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2. Angular — is used to dimension angles. Here, one has to select two non-parallel lines to 

introduce the angular dimension. 

3. Diameter — this can be invoked for dimensioning arcs and circles. 

4. Radius — it is almost identical to diameter dimensioning, except that only a radius line is 

drawn. This line has only one arrow. 

5. Dimensioning utility commands— to draw a center line or center mark for a circle/arc, 

this command issued. 

AutoCAD generally uses same type of dimensions and dimension label components as 

standarddraughting. Figure 21.19 gives examples of types of dimensions possible: linear, 

angular, diametric, radial and aligned. A number of variables such as extension lines, text 

location, tolerance specifications, arrow styles and sizes, etc., actually control the way in which 

the dimensions may appear in the drawings. 
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Self-Check 1 Written Test 

 

Name: ______________________________________    Date: _________________ 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next 
page: 

 

Part one: Choose the best answer from the given alternatives.  

1. Which one of the following draw tool is used to draw polygon.  

a. Line  

b. Circle  

c. Polygon  

d. Polyline  

2. One of the following modify tool is used to duplicate the given object. 

a. Mirror 

b. Copy 

c. Move   

d. Erase 

3. One of the following is true. 

a. CAD mean computer Aided Drafting 

b. Mirror is used to draw a symmetrical objects 

c. Erase is used to remove or delete the drawing 

d. None of the above 
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e. All are correct 

4. A modify tool which is used to cut the unnecessary part of the drawing. 

a. Trim  

b. Extend  

c. Scale  

d. Erase  

5. A dimension tool used to make the angle of an inclined line. 

a. Linear dimension  

b. Aligned dimension  

c. Diametric dimension  

d. Angular dimension  

 
Part two: MATCHING 

“A”       “B” 

 

1. Erase     A. used to draw the symmetrical objects  

2. Copy     B. used to enlarge or reduce the size of the object.  

3. Move     C. used to enlarge the short lines  

4. Offset     D. used to cut the extended lines   

5. Mirror     E. used to separate the group of lines  

6. Scale     F. used to move the object  

7. Trim     G. used tooffset with known interval  

8. Extend    H. used to break a line  

9. Break     I  used to delete the unnecessary drawing 

10. Explode    J. used to duplicate the objects 

 

Part three: Short answer  
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Answer Sheet 

 

 
 
Name:  _________________________             Date:  _______________ 
 
Part one: multiple choices  

1. _____ 

2. _____ 

3. _____ 

4. _____ 

5. _____ 

Part two: matching  

1. ______ 

2. ______ 

3. ______ 

4. ______ 

5. ______ 

6. ______ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - _10_ points  Unsatisfactory - below 10points  
You can ask you teacher for the copy of the correct answers. 
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7. ______ 

8. ______ 

9. ______ 

10. ______ 

Part three: short answer questions  

1. ________________________________________________________________________
___________________________________________________ 

2. ________________________________________________________________________
___________________________________________________ 

3. _______________________________________________________ 

 
 
 
 
 
 
 
 
 
 

Operation Sheet 1 locatting and modifing Existing CAD drawings 

 

Procedures: 

 
2. Start auto CAD  

a. Start--- all program----auto desk---auto CAD. Or 
b. Double click on CAD icon on the desk top. Or  
c. Right click on CAD icon ---- open 

3. Display the necessary tool bars  
a. Draw tool bar  
b. Modify tool bar  
c. Standard tool bar  

4. Make adjustment  the necessary information 
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a. units,  
b. drawing limits, 
c.  dimension style, 
d. Layers, etc... 

5.  Prepare the given drawing or project. 
6. Edit or modify the drawing by adding or removing or.... 
7. Stored your drawing /save/ 
8. Print the prepared drawing /output/ 

 

Exercise  
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LAP Test  

 
 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________  Time finished: ________________ 

 

Instructions: Given necessary templates, workshop, tools and materials you are required to 

perform the following tasks within 3  hours. 

 

Task 1: Clean the given tools and equipment. 

 

Task 2: list the different modify/editing/ tools and their functions. 

Task 3:  Using the given template, prepare a computer lab schedule for the specific area in the 

workshop. In preparing the CAD schedule -   

 identify the: 

 Required soft ware  

 Type of drawing and modifying/editing/ of drawing  

 Computer lab. 

 consider the: 

 procedures and standards 

 frequency of maintenance activities 

 

Task 4:  Perform the auto-CAD software in the assigned computer lab.  
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Plate Number 1 
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Plate Number 2 
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Plate Number 3 

 

 

Reference  

 Beginning AutoCAD 2018: Exercise Workbook 

•  AutoCAD 2018 Tutorial First Level 2D Fundamentals 

•  AutoCAD 2018 For Beginners 

•  AutoCAD 2017 For Beginners 

•  Beginning AutoCAD 2017: Exercise Workbook 

•  AutoCAD 2018 For Beginners 

•  AutoCAD Plant 3D 2018 for Designers 

•  AutoCAD For Dummies 

•  Mastering AutoCAD 2019 and AutoCAD LT 2019 

•  Beginning AutoCAD 2016 

•  Mastering AutoCAD 2016 and AutoCAD LT 2016: Autodesk Official Press 

•  AutoCAD 2018 For Architectural Design 
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Instruction Sheet Learning Guide #14 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics: 

 Saving  Drawing files  

 printing drawing files using  plotter or equivalent devices 

 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to: 

 Drawing files are saved in the appropriate format in accordance with standard 

operating procedures. 

 Drawing files are printed out using plotter or equivalent devices. 

 

Learning Instructions:  

3. Read the specific objectives of this Learning Guide.  

4. Follow the instructions described below 41.  

5. Read the information written in the information “Sheet 1, and Sheet 2,  

6. Accomplish the “Self-check 1, and Self-check 2, in page 152, and 155respectively.  
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1.1How to set AutoCAD save version 

1.) Right click on the command line and select Options (or Launch Options as desired) 

2.) Go to the Open and Save tab 

3.) In the top left you will see a drop down under the Save as Section This is the version it is 

currently saving as. 

4.) select the version you want AutoCAD to save to and select OK 

Now your AutoCAD is set to save to the version you selected in the Options Dialog Box 

 

Note: 

- Objects that were created in newer versions and were not available in the version you are saving 

to will be lost in most cases 

- Vertical programs such as Civil 3D , Architecture, etc have their own custom Objects and in most 

cases are not backwards compatible and the 

 

vertical Options will be disabled ( You will not be able to use the commands for that program in the 

earlier version) 

Quick Save 

The QSAVE command is equivalent to clicking Save on the File menu. 

If the drawing is named, AutoCAD saves the drawing using the file format specified on the Open 

and Save tab of the Options dialog box and does not request a file name. If the drawing is 

unnamed, AutoCAD displays the Save Drawing As dialog box (see SAVEAS) and saves the 

drawing with the file name and format you specify. 

 

1. Press CTRL + S. 

  or 

2. Click the Save icon. 

  or 

3. Type QSAVE at the command prompt, 

  Command: QSAVE 

TIPS: Drawings can be saved as different versions of AutoCAD (e.g. R13, R14, R 

2000, etc.) 

Information Sheet-1 Saving  Drawing files  
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Self-Check _1_ Written Test 

 

Name: ______________________________________    Date: _________________ 

Directions: Answer all the questions listed below. Use the Answer sheet provided in the next 
page: 
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Part one: Choose the best answer from the given alternatives.  

1. Press CTRL + S. do not save on auto cad processes 

a. TRUE 

b. FALSE 

 

2. The QSAVE command is equivalent to clicking Save on the File menu. 

a. TRUE 

b. FALSE 

 

 

 
 
 

 

Answer Sheet 

 

 
 
Name:  _________________________             Date:  _______________ 
 
Part one: multiple choices  

1. _____ 

2. _____ 

 

 
 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - _10_ points  Unsatisfactory - below 10points  
You can ask you teacher for the copy of the correct answers. 
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Plotting the drawing  

AutoCAD drawing may be plotted either by a pen plotter or a printer plotter. Pen plotters are very 

accurate and multiple colors may be obtained. Printer plotters have limited resolution and smaller 

paper sizes and produce monochrome output. However, printer plotters are usually faster than 

pen plotters. For pen plotter, PLOT command is used, whereas for a printer plotter, PRPLOT 

command is used. 

           While beginning a plot from the main menu, tell AutoCAD, which portion of the drawing to 

be plotted. Specify the part of the drawing to be plotted by entering: Display, Extents, Limits, 

View or window: the response specifies a rectangular area of the drawing. 

By Specifying: 

D (Display) — this option plots the view that was displayed in the current view 

port just prior to the last SAVE or END command for that drawing. 

E (Extents) — this option is similar to ZOOM extents. The extents are updated 

automatically as one draws new entities. 

L (Limits) — plots the entire drawing area as defined by the drawing limits. 

V (View) — plots a view that was previously saved, using the drawing editor’s 

view command. 

W (Window) — plots any portion of the drawing. Specify the lower left corner and 

upper right corner of the area to be plotted. 

Basics of operating system  

Operating system falls in the category of system software. An operating system is a set of 

programs designed to manage the entire operations of computer system. Basically the operating 

system performs two fundamental tasks for the computer: 

(i) managerial task (ii) interface task 

Information Sheet-2 
printing drawing files using  plotter or 

equivalent devices 
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The operating system does not do any specific task, but it is a general program which assists the 

user by doing the following operations: 

— Controlling all the operations including input/output operations, arithmetic operations and 

internal transfer of information. 

— Communicating with peripheral devices (printer, disk and tape device). 

— Supporting the running of other software. 

One can say that the computer system without an operating system is like an office with out a 

manager. 

SAVE Command—AutoCAD provides the following commands to save the work/drawing on the 

hard disk/ floppy diskette: 

SAVE SAVEAS QSAVE 

Command: SAVE 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Self-Check __ Written Test 

 

Name: ______________________________________    Date: _________________ 
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Directions: Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

 

Part one: Choose the best answer from the given alternatives.  

1, AutoCAD drawing may be plotted either by a pen plotter or a printer plotter  

A, TRUE 

B, FALSE 

 

2, An operating system is a set of programs designed to manage the entire operations of 

computer system.  

 
A, TRUE 

B, FALSE 

 

 

 

Answer Sheet 

 

Name:  _________________________             Date:  _______________ 

Part one: multiple choices  

3. _____ 

4. _____ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - _10_ points  Unsatisfactory - below 10points  
You can ask you teacher for the copy of the correct answers. 
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Reference 

 

 Beginning AutoCAD 2018: Exercise Workbook 

•  AutoCAD 2018 Tutorial First Level 2D Fundamentals 

•  AutoCAD 2018 For Beginners 

•  AutoCAD 2017 For Beginners 

•  Beginning AutoCAD 2017: Exercise Workbook 

•  AutoCAD 2018 For Beginners 

•  AutoCAD Plant 3D 2018 for Designers 

•  AutoCAD For Dummies 

•  Mastering AutoCAD 2019 and AutoCAD LT 2019 

•  Beginning AutoCAD 2016 

•  Mastering AutoCAD 2016 and AutoCAD LT 2016: Autodesk Official Press 

•  AutoCAD 2018 For Architectural Design 
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Drawings 

LG Code: CON RCW2 MO5 LO5-LG-98 

TTLM Code: CON RCW2 TTLM 1019v1 

LO5:-Perform exit and shut-down 
procedures 

 
 
 

Instruction Sheet Learning Guide #14 

This learning guide is developed to provide you the necessary information regarding the following 

content coverage and topics: 

 shut down Programs and computer 

 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to: 

 Basic CAD drawings are created and guidance is sought as required. 
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 Drawings are prepared in accordance with standard operating procedures. 

 As required, CAD drawings are reviewed with supervisor and/or other designated staff in 

accordance with company procedures 

 Detailed drawing is produced in third angle projection, including auxiliary views, sections 

and assemblies 

Learning Instructions:  

7. Read the specific objectives of this Learning Guide.  

8. Follow the instructions described below 41.  

9. Read the information written in the information “Sheet 1, Sheet 2, Sheet 3 Sheet 4 Sheet 5 

Sheet 6 and Sheet 7”. 

10. Accomplish the “Self-check 1, in page 161respectively.  

 

  

 

 

 

 

 

 

 

 

 

 

 

1.1shut down Programs 

The current drawing is closed. If you modified the drawing since it was last saved, you are 

prompted to save or discard the changes. To save changes to a read-only file, you must use the 

SAVEAS command and you should close the saved AutoCAD file by clicking the top right corner of 

the screen . 

 

1.2Shutting Down the computer 

Information Sheet-1 shut down Programs and computer 
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At the bottom of the right pane is the Shut down button. Click the Shut 

down button to turn off your computer. 

Clicking the arrow next to the Shut down button displays a menu with 

additional options for switching users, logging off, restarting, or shutting 

down. 

• Switch user: If you have more than one user account on your computer, Fast User Switching is an 

easy way for another person to log on to the computer without logging you off or closing your 

programs and files. 

• Log off: When you log off from Windows, all of the programs you were using are closed, but the 

computer is not turned off. 

• Lock: Locking your PC is a good option if you’ll be back soon. You'll have to enter your password 

when you come back, which helps keep your work more secure.  

5 

• Restart: The Restart button "reboots" your computer (it is sometimes called a "warm boot" or "soft 

boot.") That means it saves your information to the hard drive, turns off the computer for a moment, 

and then turns it back on again. 

• Sleep: Clicking on Sleep puts your computer in a low-power state, but doesn't turn it off. The main 

advantage is that it allows you to get back to work quickly, without having to wait for the computer 

to do a full reboot 

Unlike most electrical appliances, a computer shouldn’t be turned off by pressing the same button 

that you pressed to turn it ‘on’. If you do that, you can actually lose data or damage some of the 

processes in the machine. Think of turning off the computer properly as letting it fall asleep – just 

pushing the ‘on’ button or unplugging the computer would be like knocking it out with a punch! 

Follow these step-by-step instructions to help you turn off your computer 

These instructions are for Windows 7, but earlier versions are very similar. 

For Windows 8, see our guide 'How to shut down Windows 8'. 

 

Step 1: Click the ‘Windows’ button at the bottom left-hand corner of your screen. 

 

Step 2: Click Shut down. 

 

Step 3: If you’ve left any programs running or documents open, you’ll get a message similar to this: 

 

You have two options now: 
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Click Cancel and then close everything that had been listed in the message, saving when 

necessary. Then try closing again. 

or 

Click Force shut down. The computer will automatically close all your documents, programs and so 

on without saving anything. As a result, you may lose some data 

Press the Windows key on the keyboard or click Start. 

Click the Shut down button. 

-or- 

Press Ctrl+Alt+Del and click the power button in the bottom-right corner of the screen. 

-or- 

From the Windows desktop, press Alt+F4 to get the Shut down Windows screen and select Shut 

down. 

Tip 

If you have no mouse, use the Tab key and arrow keys to switch between fields and the Enter key 

or the spacebar to select what is highlighted. 

 

 

 

 

 

 

 

 

 

 

 

Short Answer Questions 

 

1. The Restart button "reboots" your computer  

a.Restart: 

b. shutdown 

c. booting 

d. All 

Self-Check 1 Written Test 



 

    
 
 

 
Page 163 of 167 
 

Federal TVET 
Agency 
Author/Copyright  

TVET program titleROAD CIVIL 
WORKS    

Version -1 
October 2019 

 
 
 

2. Press Ctrl+Alt+Del and click the power button in the bottom-right corner of the screen. 

 a.Restart: 

b. shutdown 

c. booting 

d. All 

 

 

 

Answer Sheet 

 

 

 

 

Multiple Chose Test Answer 

 

 

Name:  _________________________             Date:  _______________ 

 

Short Answer  

 

1.   

  

2.     

 

 

                           Reference  

 

 

 Beginning AutoCAD 2018: Exercise Workbook 

•  AutoCAD 2018 Tutorial First Level 2D Fundamentals 

•  AutoCAD 2018 For Beginners 

•  AutoCAD 2017 For Beginners 

•  Beginning AutoCAD 2017: Exercise Workbook 

•  AutoCAD 2018 For Beginners 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating – 2 points            Unsatisfactory - below 2 points  
You can ask you teacher for the copy of the correct answers. 
 



 

    
 
 

 
Page 164 of 167 
 

Federal TVET 
Agency 
Author/Copyright  

TVET program titleROAD CIVIL 
WORKS    

Version -1 
October 2019 

 
 
 

•  AutoCAD Plant 3D 2018 for Designers 

•  AutoCAD For Dummies 

•  Mastering AutoCAD 2019 and AutoCAD LT 2019 

•  Beginning AutoCAD 2016 

•  Mastering AutoCAD 2016 and AutoCAD LT 2016: Autodesk Official Press 

•  AutoCAD 2018 For Architectural Design 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Answer kay 

Lo, 1        self check 1 

 

1, B 

2, A 

3, E 

4, C 

self check 2 

1. D 
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2. A 

3. D 

• SELF CHECK 3 

1. C 

2. A 

• SELF CHECK 4 

1. A 

2. A 

3. D 

4. B 

5. B 

 
Lo,  2self check 1 
 

1, D 
2, B 
3, C 
4, A 

self check 1 
1. A 
2. A 

 
 
 
 
 
Lo,  3self check 1 
1. C 
2. C 
3. E 
4. A 
5. D 

MATCHING 
1. I 
2. J 
3. F 
4. G 
5. A 
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6. B 
7. D 
8. C 
9. H 
10. E 

 
Lo,  4self check 1 
 

1. B 
2. A 
self check 2 
1. A 
2. A 

Lo,  5self check 
1. A 
2. A 
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B (NIFAS SILK Polly Technique College) 

4 HABIB SURUR B  (HAWASA Polly Technique College) 

No Name Qualification 
level 
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1 AYELE  A ( ADIS ABABA TVET  Bureau) 


